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This manual is the instructions for use for MyoStrain version 5.4 

 

Indications for Use Statement: 

 
MyoStrain software is an image processing device that post-processes strain-encoded (SENC) images, which are acquired by MRI 
systems equipped with a SENC pulse sequence.  MyoStrain software receives SENC images from MRI storage and archives, and 
performs extraction of time-resolved, quantitative strain information per voxel and other cardiac measurements, viewing, image 
manipulations, communications, and printing.  Available measurements include longitudinal and circumferential strain to 
quantitatively describe the wall motion of the heart.  Tools are provided to display regional motion properties of the heart.  
A report interface is provided. Measurement tools provide information that can be output in standardized or specialized report 
formats.  This interface makes it possible to quickly and reliably fill out a complete clinical report of a cardiac imaging exam with 
strain.  The results of the measurement tools are interpreted by the physician and can be communicated to referring physicians to 
support the determination of a diagnosis. 

 
 
 
Patient Population: 
MyoStrain is used by physicians, radiologists, and cardiologists.  MyoStrain can read any MRI image created by MyoStrain or the 
Strain-ENCoded (SENC) pulse sequence, so any patient who can have a SENC Cardiac MRI scan can be included in the patient 
population. 
 
 

 

Contraindications and Warnings:  

 

• MyoStrain is a post-processing software that does not interact with the patient.  To obtain the images used for 
MyoStrain, the user must follow all the Contraindications and Warning from the MR imaging manufacture, to ensure the 
safety of the patient and the staff. 

• MyoStrain is designed for the analysis of SENC MR images of the heart. The results of quantification will depend on the 
image quality. 

• MyoStrain, is intended to be used by the physician along with other indicators, such as patient history and pain level, to 
determine the diagnosis of the patient.     

 
 
MR Manufactures with approved SENC Pulse Sequences 

Philips MR Systems with 5.6 software or higher, with the SENC Pulse Sequence 
 United Imaging Healthcare MRI scanners with the SENC Pulse Sequence.  
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1. INTRODUCTION 
 
This User’s Manual was written to assist you with a better understanding of MyoStrain and to maximize the 
efficiency of the software. Use this manual to look up information, find out what you need to know, and start your 
work.  

 USING THIS MANUAL 
This manual is designed to provide a thorough description on how to use the to analyze cardiac magnetic 
resonance (MR) images. 
 
The following symbols and formats are used to denote different types of instructions: 
 

All user interface elements have been marked in bold. 

Additional information on application functionality or features can be found in small notes. 

NOTE: Notes are written in this format. 

Ø Example: Examples are written in this format. 

 
Caution –Important cautionary information such as warnings and precautions 

 
Information –Consult instructions for use 

 
Manufacturer – Identifies who developed and released the MyoStrain software. 

 
Unique Device Identifier – Indication that a Unique Device Identifier is present 

 
Medical Device – Indication that the device is a medical device 

 

 ABOUT MYOCARDIAL SOLUTIONS 
Myocardial Solutions, Inc., based in RTP, North Carolina, is a privately held company specializing in unique MR 
imaging and diagnostic solutions for research, clinical, and OEM markets.  “Our mission is to give patients control 
over their heart health, providing physicians with unique diagnostic solutions to help transform the detection, 
prediction, and management of heart dysfunction.”  
 

1 



   

 

 
_________________________________________________________________________________ 

User’s Manual LBL-1015 Rev G Confidential Page 8 

 

 KEY FEATURES 
The MyoStrain software presents a simple interface that enables you to analyze SENC (Strain ENCoded) MR images 
without a steep learning curve.  MyoStrain enables physicians in private practice, research, and drug development 
to: 
 

• Analyze short-axis and long-axis views of the LV and RV. 

• Quantify and visualize regional function in a format readable by physicians and patients alike 

• Create bull’s-eye charts and other forms of data presentations. 

• Easily visualize heart wall motion changes during stress examinations  

Export results in a PDF document. 

 

 SYSTEM REQUIREMENTS 
Before you install or use MyoStrain V5.4 ensure that your computer meets the following requirements: 
 

1.4.1 RECOMMENDED HARDWARE REQUIREMENTS 
 

1. 3.2 GHz Gen 4 i3 Processor or higher 

2. Windows 10 or Windows Server 2016 

a. Professional Edition or higher 

b. 64-bit versions only 

3. 16GB memory or higher 

a. 8GB required 

4. 100 GB available hard disk space for installation and additional space for image storage 

5. 1920x1080 screen resolution 

6. 64-bit video card with 1GB memory 

7. 1000Mbps LAN 

8. .NET Framework 4.8 (installed alongside MyoStrain if not present) 

9. Visual C++ Redistributable Package 2019  (installed alongside MyoStrain) 

 

1.4.2 SCREEN RESOLUTION 
Depending on your workstation’s configuration, some parts of the application may be hidden or display in an 
unusual manner.  MyoStrain is designed to be flexible and has many options to change how the software displays 
data.  We have tested multiple different form factors and recommend the following settings (your configuration 
may be different).   

Supported resolutions: 
1. 1920x1080 (1080p) (Recommended)– Windows Scaling set at 100%  
2. 2736x1824 (Microsoft Surface) – Windows Scaling set at 200% 
3. 3840x2160 (4k) – Windows Scaling set at 150% 
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1.4.3 OPERATING SYSTEM 
The MyoStrain application is currently supported on Windows 10 (64-bit) and Windows Server 2016. 
 

 CYBERSECURITY 
MyoStrain is only available from Myocardial Solutions, and installations are only authorized on systems identified 
as being secure.  Myocardial Solutions requires that the below practices are being followed before authorizing 
installation or upgrades of MyoStrain: 

• Access to the workstation (internally and externally) is limited to only authorized and trusted users of 
MyoStrain. 

• Access to the workstation is monitored 

• Only trusted content (including MyoStrain and its software libraries) will be loaded onto the workstation 

• The workstation is equipped with mechanisms designed to detect, respond to, and recover from malware or 
other compromising applications (Anti-virus, anti-malware software, firewall) 

• The workstation must automatically log off and restrict access after a reasonable period 

• A backup and disaster recovery plan should be in place on the workstation 

• Integrity and confidentiality of data transferred to and from the workstation must be monitored 

• MyoStrain data stored on the workstation is encrypted 
 
 

1.5.1 TRANSMISSION OF DATA 
MyoStrain can be configured to use any network ports to receive and send data.  MyoStrain will only open ports 
and network paths to locations where the workstation or application is provided access to. Myocardial Solutions 
will work with the facility to ensure the ports are secure.   
 
MyoStrain will not knowingly transmit data to any devices or systems not identified as a connected PACS server 
(Section 10.1). MyoStrain will only receive DICOM formatted data sent to it as part of a configured node system. 
MyoStrain will not transmit any information to an outside server or service without express confirmation on behalf 
of the operator.  Information related to the receiving of data from across a network is logged and is available on 
the workstation running MyoStrain.  The log files can be found in the following path, where (USER) is the logged-in 
user’s name: C:\Users\(USER)\AppData\Local\Myocardial\MyoStrain Test\Logs. 
 
After any data has been sent to MyoStrain, it will be stored in a folder specified during the installation (Default 
path is C:\MyoStrain\).  Datasets sent to MyoStrain will be stored in the same state it is received until manually 
updated. 

 

1.5.2 ENCRYPTION OF DATA 
All information related to the processing of image data during a software exam (.myo save data files) is encrypted.  
This information cannot be accessed except by MyoStrain. Encryption of image data as well as secure transfer of 
data is a requirement of the facility prior to installation of the MyoStrain software. 
 

1.5.3 INTEGRITY OF DATA 
MyoStrain will perform a check periodically to verify the integrity of system files and ensure repeatable results on a 
known dataset.  This check verifies analysis integrity if the workstation’s cybersecurity has been compromised. This 
check (known as Self-Check) is conducted upon installation of the software, a reorder form is generated, upon 
request, or after a year has passed since the last Self-Check. MyoStrain will not launch if this test fails.  Please 
contact Myocardial Solutions (support@myocardialsolutions.com) for more information.  
 
  

mailto:support@myocardialsolutions.com
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2. GETTING STARTED 
 
This chapter explains the installation and default operation of the MyoStrain analysis software. 

 INSTALLING MYOSTRAIN V5.4 
The MyoStrain installation process on the workstation is a very simple and straightforward process.  Installation is 
performed on-site and configured by Myocardial Solutions on a site-by-site basis.  If your site needs to install or 
reinstall MyoStrain, please contact Myocardial Solutions’ support team (support@myocardialsolutions.com) to 
arrange an installation session. 
 

 
Figure 2-1: Installation Window 

 
 

1. Launch the MyoStrain installer. Click the Next button when the installation screen shown in Figure 2-1 
appears. 

2. Please read the license agreement, and if you agree select the “I accept the terms in the license 
agreement” option shown in the second installation window (Figure 2-2).   

3. The Configuration stage of the installation wizard contains site-specific information which may change 
from site to site.  Please contact your site administrator or Myocardial Solutions for more information on 
these fields. 

 

2 

mailto:support@myocardialsolutions.com
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Figure 2-2: End User License Agreement – Accept must be selected to continue 

 
 

4. After the Configuration information has been set, click Next.  Select Install on this last page to initiate the 
final step of the installation process. 

 

2.1.1 UPGRADING TO V5.4 
If a previous version of MyoStrain is already installed on the workstation, the MyoStrain installation package will 
upgrade the installed version to the current release.   
 

 
Figure 2-3: Installation Wizard – Upgrading 
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Upgrading to version 5.4 will import analysis and configuration settings from the previous installation, including 
PACS server information and Worklist data.  During the installation process, a directory must be created to store 
this information for upgrade, by default MyoStrain will use C:\MyoStrainBackup. 
 

NOTE: The MyoStrain installer will always attempt to upgrade an existing MyoStrain installation.  To bypass 
upgrading, first uninstall the current MyoStrain installation.  Ensure the MyoStrain program as well as the 
MyoWorklist are closed before uninstallation/upgrading.   

 

 ACTIVATING MYOSTRAIN V5.4 
Upon launching MyoStrain for the first time, or if the MyoStrain Application license has expired, the Registration 
dialog box will display as shown in Figure 2-4.  Copy the value given in the Username field and email it to Customer 
Support (support@myocardialsolutions.com). 
 

 
Figure 2-4: Registration dialog box 

 
 

2.2.1 MYOSTRAIN SELF CHECK 
After installing MyoStrain, when a Reorder request is started, or a year after the last check, a Self-Check will be run 
by the program.  This Self-Check system verifies the integrity of installed files on the workstation, then runs a 
diagnostic analysis to verify measurements being read by the application.   
 

 
Figure 2-5: Self Check running 

 
A progress bar will appear once the test has begun.  After the check has been completed, a dialog box will appear, 
detailing information regarding the test.  If the Self-Check fails, please contact Myocardial Solutions’ Technical 
Support for more information (support@myocardialsolutions.com). The program will not run if the Self-Check fails. 
 

mailto:support@myocardialsolutions.com
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Figure 2-6: Successful Self Check notification 

 

 IMAGE IMPORTATION 
MyoStrain provides multiple different methods to import images for analysis.  While the methods for importing 
images may differ, the end goal of quantifying a series of resting strain (and in cases of Stress testing, measuring 
the difference between those and stressed) stays the same.   
 

2.3.1 INPUT IMAGES REQUIREMENTS 
MyoStrain imports and analyzes SENC images, which are acquired with SENC-ready MRI systems. SENC-ready MRI 
systems are MRI systems equipped with the SENC pulse sequence.  SENC images are identified by specified DICOM 
series attribute 'SENC'.  
 

MR Manufactures with approved SENC Pulse Sequences 
United Imaging Healthcare MRI Scanners with the SENC Pulse Sequence.  
Philips Ingenia, Ingenia Elition and Ingenia Ambition MR Systems with 5.6 software or higher, with the 
SENC Pulse Sequence.  

 
 

2.3.2 INPUT IMAGES RESTRICTIONS 
 
MyoStrain processes SENC images and measure the strain in the through-plane direction. The specific strain 
measured will depend on the orientation of the imaging plane. Circumferential strain is measured from long-axis 
planes of the heart, while longitudinal strain is measured from short-axis planes.  
 

 

The prescription of the planes is the responsibility of the MRI scanner operator, who should be 
properly trained on cardiac imaging and the recognition of the correct views of the heart. 

 
The user of MyoStrain can verify the right orientation (angle tilting) of the acquired planes by reviewing the 
location and orientation of each plane relative to the anatomical images, as seen on MyoStrain screen. The user 
therefore can match the type of the strain measured to the location and orientation of the plane. 
 
While MyoStrain can import any properly formatted image, it cannot identify what is an analyzable image.  Image 
quality, acquisition, and other factors can prevent the accurate quantification of image data.  Accuracies of 
measurements are associated with images that were correctly acquired and analyzed by trained operators. It is the 
responsibility of the trained MRI operator and MyoStrain users to check the quality of the acquired images before 
post-processing them using MyoStrain. 
 
Other acquisition issues can cause the images to be unanalyzable.  Below are 3 examples of mis-acquisition.  
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Figure 2-7: Sample Image of 2-chamber view with planning issue 

 
Figure 2-7 demonstrates an image that needs to be re-acquired.  In this example, the apex of the 2-chamber view 
is not captured at systole.  During acquisition, the patient shifted their body and caused the heart to fall outside of 
the field of view.  This would require a new acquisition. 

 
Figure 2-8: Two images of the same 2-chamber view 

Figure 2-8 demonstrates an acquisition that began at end-systole (frame 2/11, left) instead of end-diastole (frame 
10/11, right).  Rather than showing the complete cycle of the heart going from end-diastole, to end-systole, and 
back to end-diastole, this series is only showing the relaxation from end-systole to end-diastole. This caused the 
strain to not be applied to the dataset.  If the dataset does not show the full diastolic to systolic cycle, the series 
should be rejected. 

LV LV 

LV 

No Apex of the LV 
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Figure 2-9: Unidentifiable 

 
Figure 2-9 should be rejected as well.  In this example, the acquisition plane was not set correctly.  For reference, 
this image is of a 2ch Long-Axis slice.  This would require a reacquisition. 
 
All images used for analysis demonstration in chapter 4 can be considered of good analysis quality.   
 
Please refer to sections 5.4.2 and 6.4.2 for more information on how to reject images from analysis. 
 
 

2.3.3 LOCAL FILE IMPORT 
In most circumstances, images being analyzed in MyoStrain are typically coming directly from the scanner.  In 
cases where networking is unavailable, or images copied off a CD need to be analyzed, local file import is available. 
 
 

 
Figure 2-10: Image Import from Folder (New Exam) option found in the File menu 
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To import a local dataset, click on File>New Exam from Folder from the File menu found in the upper-left hand 
corner of the MyoStrain application.  A Browse for Folder dialog box will appear, prompting the user to select a 
folder containing medical images.  All images contained in the folder (this includes any subfolders found in this 
folder) will be imported into MyoStrain and organized according to stress stage found in the medical image header. 
 
All MyoStrain data used as part of the analysis will be stored in this folder.  Image data will be maintained in that 
folder and is the responsibility of the Facility’s IT department to find a secure location to archive and store this 
exam information. 
 

2.3.4 REMOTE FILE IMPORT 
 
For more information regarding remote file importation, please refer to chapter 10.  When used as part of a live 
patient stress examination, MyoStrain will automatically identify and organize images based on stress level.  After 
a timed delay (default setting of two minutes) specified during the installation process, future images will be 
organized under the next level stress phase if performing a Stress exam.  This means that after the last image has 
been received by the application, any images received before two minutes have elapsed will be included in the 
current phase.  Any images received after the delay has expired will be added to a new stress phase.   
 
After any data has been sent to MyoStrain, it will be stored in a folder specified during the installation (Default 
path is C:/MyoStrain/).  It is the sole responsibility of the Facility’s IT Department to ensure that any data sent to 
MyoStrain is accessed, managed, and archived for future use.    
 
For more information regarding the MyoWorklist, please refer to chapter 10 for more details. 
 

 DICOM CONNECTIVITY CONFIGURATION 
When MyoStrain 5.4 is installed, an additional service named MyoWorklist is also installed on the workstation.  
This service is responsible for managing datasets sent to the application for retrospective analysis from other 
computers via DICOM.  MyoStrain will only receive data pushed from remote locations it has been configured to 
receive from and can be configured to receive data from multiple devices.  Please contact your PACS or network 
administrator or support@myocardialsolutions.com to setup this feature.  You can also refer to section 10.1 for 
more information about DICOM connectivity configuration and how to enable MyoStrain to receive images 
remotely. 
 

NOTE: Only DICOM formatted data can be transferred through this configuration.   

 
 

 ERROR REPORTING 
When using MyoStrain, very rare circumstances may cause the application to encounter an error.  If an error does 
occur, please send the entire error message to Customer Support (support@myocardialsolutions.com) along with 
your name and the organization/practice you are affiliated with.  A representative will contact you to help 
troubleshoot your issue.   
 

mailto:support@myocardialsolutions.com
mailto:support@myocardialsolutions.com
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Figure 2-11: Sample error message 

In the rare case MyoStrain crashes without generating an error message, please contact Customer Support 
(support@myocardialsolutions.com) describing any actions preceding the crash.  A Customer Support 
representative will be in contact to assist troubleshooting the error. 

 EXAM LICENSES 
MyoStrain operates by using an exam credit once images are received by the application in Stress or Strain analysis 
mode.  If the application no longer has any exam credits remaining, it will not receive or process any new images.  
To order additional exam credits, launch the About menu by clicking on the Myocardial Solutions logo found below 
the ‘X’ at the top-right of the application window. 
 

 
Figure 2-12: License information is available from this menu 

 

The About menu, available from both the Exam Selection screen as well as the main program, displays relevant 
information related to the software license.  Exam credits can be requested or added into the program from this 
menu. 

 
Figure 2-13: Exam selection screen shown at beginning of new exam or at launch 

 

mailto:support@myocardialsolutions.com
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To view detailed exam license information, click on the Show Exam Licenses button shown at the top of the About 
menu (Figure 2-14).  This will display another menu which will display all the exam licenses available to the 
workstation and their duration (Figure 2-15).  Exam licenses will always be consumed starting with the first entry, 
then cascading down the list until no additional exam licenses are available. 
 

 
Figure 2-14: Additional exam license information can be found in the About menu 

’ 

 
Figure 2-15: List of exam licenses available to the workstation running MyoStrain. 

 
 

2.6.1 ORDERING ADDITIONAL EXAM LICENSES (REORDER FORM) 
 

NOTE: Please check with your organization’s ordering procedures before submitting a request for additional 
licenses. 

Clicking on the Reorder button found in the bottom-center of the About menu will launch a new popup window 
(Figure 2-16). 
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Figure 2-16: License Reorder Form Wizard 

 
After filling in all the required fields (marked by a red asterisk), including a number for Strain and Stress, a report 
will be available for export.  Clicking on the Print button will bring up a Print Dialog box (Figure 2-17) allowing the 
user to print out a physical copy of the report (provided a printer is available). 
 
 

 
Figure 2-17: Selecting Print from this window will generate a physical copy of the Reorder Form 

 
A digital copy can also be created by using the Export button from the License Reorder window (Figure 2-18) as 
well.  Select a location to export the report to using the Choose Folder button, rename the Reorder form using the 
File Name field, then click Save to export the report. 
 

 
Figure 2-18: Digital copies of the Reorder form can be created here 

 
Once the Reorder form has been created, it must be attached to the Purchase Order sent to Myocardial Solutions 
for processing.  Please refer to the below chart for details where this Reorder form should be sent. 
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Email  orders@myocardialsolutions.com 

Fax  +1 (919) 591-0404 

 
 
 

NOTE: orders@myocardialsolutions.com will not contact you or reply directly to emails.  A representative will 
contact the person listed on the Reorder form, or directly with the person who sent the email if there are any 
errors. 

 
 

2.6.2 ADDING ADDITIONAL EXAM LICENSES 
By clicking on the Myocardial Solutions logo found either on the Select Your Exam or main application window, an 
About dialog box will appear (Figure 2-19).  Clicking on the Exam License button will open the Registration window 
(Figure 2-20).  Copy and paste any new license codes into the Exam License field and click Add to add additional 
exam credits. 
 

 
Figure 2-19: MyoStrain About page 

 

mailto:orders@myocardialsolutions.com
mailto:orders@myocardialsolutions.com
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Figure 2-20: Exam License entry screen 

 

NOTE: License codes generated by Myocardial Solutions expire 7 days after being issued. 

 APPLICATION LICENSE 
In addition to the Exam License, the software is also governed by an Application License.  This license determines 
how long the program will remain active and able to review exams created in the program. The Application License 
can be found by clicking the Application License button found in the About screen. If the Application License is 
expired, MyoStrain will not launch and instead display the Registration window seen in section 2.2.   
 

 
Figure 2-21: Application License menu  

 

NOTE: The MyoStrain Application license is separate from the Exam License.  MyoStrain will continue to run if there 
are no remaining Exam credits, however it will be limited to reviewing previously created MyoStrain exams. 

 

 UNINSTALLING MYOSTRAIN 
Before uninstalling MyoStrain, please contact Customer Support (support@myocardialsolutions.com) to validate 
the exam licenses available to the workstation.  If MyoStrain is uninstalled before the exam count is verified, those 
exams credits will be lost. 
 

mailto:support@myocardialsolutions.com
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Figure 2-22: Add or Remove Programs in Windows 10 

 
MyoStrain can be uninstalled through Window’s “Add or Remove Programs” feature.  Please contact your IT 
Administrator for more information about this Windows feature, or if you are unable to uninstall due to 
insufficient workstation permissions. 
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3. APPLICATION OVERVIEW 
 
This chapter provides a visual overview of the MyoStrain application, describing settings and features relating to 
MyoStrain quantification. 
 
 

 THE MYOSTRAIN WORKSPACE 
The MyoStrain application is comprised of a single window with several panes used to display information relevant 
to the current patient’s images being received by the software.  Most of the data displayed is generated as part of 
the MyoStrain analysis protocol and minimal interaction is required to display/retrieve this information. 
 
Ø Example: Consider a subject who is being imaged with MyoStrain during a stress test. In this case, the subject will 
be imaged at baseline and at different levels of stress.  Each stage of this scan will automatically be imported into 
the application and organized accordingly.   Images in this chapter will be shown in Stress Mode. 
 

 
Figure 3-1: Overview of the MyoStrain analysis window 

 

 ANALYSIS WINDOW  
Found in the upper-left hand corner of the application, this displays the active slice(s) being analyzed.  Information 
about the currently viewed slice can be added in the upper-left of the image including heart rate and blood 

3 
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pressure.  A drop-down menu is also used to identify the view for importation into the report. The right-hand side 
of the Analysis Window has five options which assist with image analysis.  Additionally, located on the right side of 
the active image is a color range used to visualize strain on the image. 
 

3.2.1 VIEW DETAILS 
Found in the upper-left hand corner of the Analysis Window, the View Details shows information regarding the 
current view and stress analysis stage.  

 

 
Figure 3-2: 4-Chamber view details (Stress exam) 

 

• View Dropdown (A)- Contains a list of six possible views analyzable during a MyoStrain analysis. 

• Heart Details (Stress Mode) (B)– This dropdown menu displays the patient’s heart rate and blood 
pressure, and allows editing from there.  Click the circle found below the View Dropdown to access these 
measures.  

o HR - Heart Rate (Stress Mode).  This value is constant across the current stress level and must be 
entered at every stage of stress during an analysis 

o BP - Blood Pressure (Stress Mode).  This data will be used for each image associated with the 
current stress level.  It is recommended to enter this data as [SYS/DIA]. 

• Stress Agent (C)- Current Stress Stage (Stress Mode).  This will display when the second series of images 
are received by the MyoStrain post-processing software.   

• Display Header (D) – Current Analysis tool active.  In the example, using the mouse anywhere inside the 
analysis window will begin drawing an LV contour. 
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• Measurement Scale (E)- This is shown on the left-hand side of the Analysis Window and displays a 
reference scale (in cm).  This changes size depending on the zoom and acquisition. 

• Video Playback (F)– This button (found above the timeframe counter) displays or hides the Video 
Playback buttons.  Please refer to section 3.2.3 for more details. 

• Current Timeframe (current time) (G) – Shown at the bottom of the image in the lower-left hand corner, 
this displays the currently viewed timeframe, the total number of images available in this slice, and the 
time of the current timeframe relative to the initial image (in milliseconds).  If a mesh is applied to the 
slice, timeframes marked in green and underlined are used in strain calculation. 

 

3.2.2 ANALYSIS WINDOW OPTIONS 
Displayed on the right-hand side of the Analysis Window, the Analysis Window Options are buttons intended to 
assist the mesh drawing process.  This includes stage timing and visualization enhancements. 

 

 
Figure 3-3: Analysis Window as seen during a Stress RV analysis with EF enabled 

• Drawing –This section displays the various analysis tools available for use in strain quantification.   
o LV/RV (RV Analysis Only) – These buttons are displayed on slices where RV quantification is 

available.  RV will only be available once an LV mesh has been drawn on the image. 
o Display Header- When selected, this displays a message in the top of the Analysis Window that 

describes what MyoStrain is expecting in the Analysis Window. 
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• Stage (Stress Analysis) - Displays a timer for the current stage.   This counter will reset whenever a new 
image is received by MyoStrain.  Once the timer reaches zero, or the Next Stage button is pressed, any 
new images will be added to a new acquisition stage in the Image List. 

• Slice - These buttons assist the user in image quantification and meshing. 
o Next Slice - Changes the image in the Analysis Window to the next available slice in the current 

acquisitions’ Image List 
o Clear Inputs (Stress Analysis) - Clears all text entered in the View Details.  This does not reset the 

selected view. 
o Undo – This reverses the most recent mesh drawing or correction.  This button will be greyed-

out if no mesh data is available. 
o Redo – Pressing this will re-apply the most recent action taken by the Undo button. 
o Reset – This resets the image view to its default state.  Any image that has been rotated or 

meshed can be reset.  A notification window will appear to confirm any Reset request. 

• Brightness/Contrast – These buttons are responsible for adjusting the image brightness and contrast for 
the current acquisition stage. 

o Noise Filter - Unchecking this box will disable the noise filter.  The noise filter by default will 
ignore signal intensity under a certain threshold, improving visual quality of the image. 

o Adjust – This button, when pressed, will change the mouse cursor to a sun icon and display two 
slider controls.  The brightness and contrast can be adjusted either by moving the sliders, 
manually updating the percentage number, or via the mouse cursor. Figure 3-4 describes how 
this adjustment works.  Clicking the Adjust button again will save all adjustments. 

o Reset - Pressing this button will reset any modifications of the brightness and contrast of the 
current acquisition. 

 

 
Figure 3-4: Holding the left-mouse button and dragging in the shown directions will adjust the brightness and contrast in the 

Analysis Menu and vice-versa 

• Zoom - Pressing this button brings up a zoom slider bar.  Using this slider, the user can zoom in on the 
image, and by using the mouse cursor in the Analysis Window, move the image. 

• Slice Navigator – This slide-bar provides another way to navigate through the currently selected slice.  
Either the buttons or slider will allow navigation between timeframes of the current slice.  End-Systolic 
and End-Diastolic timeframes are marked here as well. 

o Change ES – Sets the Orange placeholder on the Slice Navigator to its respective location based 
on the timeframe this button is pressed.  This timeframe will be used to calculate strain as 
identified during End-Systole. 
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o Change ED – Sets the Green placeholder on the Slice Navigator to its respective location based 
on the timeframe this button is pressed.  This timeframe will be used to calculate global 
measurements identified during End-Diastole. 

• Accept Mesh – Displayed only when the Semi Auto Contouring tool is enabled; pressing Accept Mesh will 
accept the software’s suggested contouring and apply it to the analysis.  This button will disappear once a 
mesh has been either accepted or corrected. Please visit chapter 9 for more information. 

• Swap – This button re-labels the current End-Systolic timeframe to End-Diastole, and the original End-
Diastolic mesh as End-Systole. 

 
Additionally, many of these features can also be accessed by right-clicking anywhere within the Analysis Window.   
 

 
Figure 3-5: Context menu displayed when right-clicking in Analysis Window 

 
The top section of this context menu refers to slice selection and will be covered in further detail by section 3.3.2. 
The middle section of this right-mouse button menu allows switching between mesh types (LV and RV drawings), 
the brightness/contrast adjustment tool, and the pan/zoom tool.  The bottom section contains mesh actions such 
as Undo and Redo. 
 

3.2.3 VIDEO PLAYBACK 
Clicking on the button found above the Current Timeframe counter will  cause several buttons to appear in the 
Analysis Window.  These buttons will allow the user to navigate between different images in the current slice. 
 

 
Figure 3-6: CINE playback buttons shown with mouse cursor placement 

 
1. Rewind Frame – Navigates one frame backwards in the series 

2. Decrease Speed - Decreases the playback speed of the series. 

3. Play - Plays through the entire slice.  Press the Play button again to stop. 

11   2   3   4   5 
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4. Increase Speed - Increases the playback speed of the series. 

5. Forward Frame – Navigates one frame forwards in the series 

NOTE: You can also use your mouse’s scroll wheel to navigate through the images of the slice, forward and 
backwards 

 
3.2.4 STRAIN LEGEND 
Strain data provides a qualitative color scheme to visualize the contraction strength of the heart muscle.  These 
color maps are automatically applied to the images being analyzed during the exam. Figure 3-6 provides a basic 
guide to the meaning of each color.  For more information on Contractility of the myocardium refer to Section 11.2 

 

 
Figure 3-7: Color Map Legend 

3.2.5 WINDOW ADJUSTMENT 
The images shown in the Analysis Window can be increased or decreased in size by adjusting the bars seen below 
and on the right-hand side of the window.  Using the handlebars, left-click and drag the sides of the Analysis 
window to adjust the available area for images to be shown.  The image will scale to fit into the largest area 
possible while maintaining the images original properties. 
 

 
 

 IMAGE LIST  
Located under the Analysis Window by default, the Image List displays all images that have been imported by 
MyoStrain as a part of the current patient study.  These are organized by the time of acquisition and correspond to 
the introduction of stress agents in the study. 
 
During the analysis, there may be colorized dots in the upper-right corner of each thumbnail in the Image List.  
These dots identify the status of that slice in the list.   
 

• Yellow – Mesh has been drawn using Semi Auto Contouring and has not been accepted.  The yellow dot 
also denotes the slice which displays the greatest strain values. 

• Green – Mesh has been completed and is selected for use in reports and data output. 
 

 
Figure 3-8: Image List as seen during a MyoStrain exam without Semi Auto Contouring enabled 

 

3.3.1 PHASE SELECTION (STRESS EXAM) 
During a stress examination, a dropdown menu will appear above each Image List.  This menu is used to identify 
and label each series of images over the course of a stress exam. 
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Figure 3-9: Stress Phase dropdown menu seen during Stress exam 

 

NOTE: Any changes to the image made in the Analysis Window are also applied in the Image List.  This includes 
brightness/contrast changes and drawn meshes.  

 

3.3.2 DUPLICATE VIEW SELECTION 
In some situations, there may be multiple acquisitions of the same view available in the Image List.  If two or more 
slices of the same view are analyzed, the software will display and report on only one of these analyzed image 
stacks. 
 

 
Figure 3-10: In the Image List, green radio buttons mark the slices being reported  

 

Figure 3-10 shows an example where two slices of the same view have been analyzed.  Only one of the two slices 
show a green dot; this slice is considered the Active slice and will be used for the report.  Drawing a mesh onto 
another slice of the same view will cause MyoStrain to automatically set that slice as active.  Right-clicking on a 
slice in the Image List brings up a context menu which will enable selection of a different slice for the report.   
 

• Select - Displays the selected slice in the Analysis Window 

• Hide - Greys out the selected slice and pushes it to the end of the current stage in the Image List 

• Activate - Enables the selected slice and sets it as active with the Green radio button 

• Unhide - Activates a slice which has been previously hidden 
 

 
Figure 3-11: Image List with 2 slices hidden from the report 

 



 

 
_________________________________________________________________________________ 

User’s Manual LBL-1015 Rev G Confidential Page 30 

 

3.3.3 IMAGE LIST ADJUSTMENT 
Similar to section 3.2.5, the size of the images shown in the Image List can be increased or decreased in size by 
using the blue handlebars seen underneath each stage of images available. 
 

  
Figure 3-12: Increasing the size of the Resting stage image list 

 REPORT VIEWER 
The right-hand side of the MyoStrain software displays information gathered from the images imported during an 
analysis.   

 
Figure 3-13: Layout of the Report section during Strain Mode 

 
1. Report Mode: see Section 3.4.1 
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2. The Patient header displays all relevant PHI on the current patient. 

3. The Measures section displays all relevant measurements gathered as part of the current exam 

4. The Findings header is a freeform textbox used to add any notes or findings relevant to the current 
analysis 

 

3.4.1 REPORT MODE 
 
At the top of the Report Viewer window are two buttons which change how the software displays images sent to it 
for analysis.  Images can be imported as part of a Stress or Strain exam.  During a Stress exam, the user can switch 
between Stress and Strain analysis modes.   
 

 
Figure 3-14: Reporting under Stress settings 

 

• MyoStress® – Enables the Measures section in Stress Exam mode.  Any images received at this point will 
exhaust an exam credit (only 1 credit per study). 

• MyoStrain® – Enables the Measures section in Strain Exam mode.  Any images received at this point will 
exhaust an exam credit (only 1 credit per study). 

 

 

 LICENSE AND EXAM CREDIT INFORMATION 
MyoStrain is governed by the license information provided on activation.  Information about the existing license 
can be seen in the upper-right hand corner of the screen and can be detailed by clicking the Myocardial Solutions 
logo found below the X of the application window.  The license can also be viewed and updated from this menu. 
 

 
Figure 3-15: Software license with 50 Stress and 50 Strain exams left that expire in 1 year. 

 

3.5.1 EXAM LICENSES 
The number of remaining exams is shown in the title bar next to the Myocardial Solutions logo.   The title bar will 
change color to alert the user when the license is close to expiration.  Options in the Settings menu will allow the 
user to define how this title bar behaves.  By default, the warnings are displayed as follows: 
 

 

• Yellow- 30 or fewer days remaining, or 10 or less Strain/Stress exams. 

• Red – 5 or fewer days remaining, or 5 or less Strain/Stress exams. 
 

Simply opening MyoStrain will not consume an exam credit.  Re-opening an older exam will also not consume an 
exam credit.  Whenever images are received by the MyoStrain application as part of a new exam, an exam credit 
will be consumed.  Images received during a new stress stage or after rejecting a series will not use a new exam 
credit.   
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Figure 3-16: Yellow caution warning 

 

 
Figure 3-17:  Red alert warning 

 

Clicking on the Reorder will launch the Reorder form and launch the Self-Check program as well. 

NOTE: Setting the Countdown Warning or Countdown Risk numbers to 0 will disable the exam count alert coloring 
and Reorder button. 

 

3.5.2 OPEN ANALYZED EXAM 
MyoStrain is backwards compatible with exams created in MyoStrain starting with version 5.1.1.  Opening an old 
exam will not consume an exam credit.  Once opened, an exam is editable and fully modifiable.   
 

NOTE: Modifications to exams imported from older versions of MyoStrain should be reviewed for mesh 
completeness before exporting exam information. 

 

 APPLICATION TOP LEVEL MENUS 
The File menu in the upper-left hand corner of the program provides a few options focused on managing exam 
data.  This is intended for revisiting a previously performed exam, or to close/save a current exam. Each entry 
labeled with a * will consume an exam credit when successfully run.  The options for the File menu are as follows: 
 

• New Exam*– Clears all data currently loaded into the MyoStrain application and displays the Select Your 
Exam screen. 

• New Exam from Worklist* - Opens an in-application version of the MyoWorklist to create new exams. 

• New Exam from Folder* – Opens a file navigation window which imports all images contained in a folder.  
MyoStrain will attempt to organize the data based on information available in the DICOM header (data 
will be organized based on Stress Stage and view) 

• Open Analyzed Exam - Opens a file navigation window to open an old exam.  

• Open Recently Analyzed Exams – Displays a list of up to 10 previously performed exams 

• Open Anonymized Myo Exam – Opens a searchable menu which links anonymized names to non-
anonymized patient information run through MyoStrain. 

• Export – 
o Export Anonymous - Exports an anonymized copy of all available measurements, reports, and 

images from the current analysis. 
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o Export Data - Exports a .csv or .xml file containing all raw strain values from all stress levels 
recorded during the exam.  Please refer to section 7.5.3 for more details regarding saving this 
file. 

o Export to DICOM - Exports a copy of all the data specified in the Export to DICOM Settings menu 
to a local folder.  The data exported is in the DICOM format, which can be viewed with a DICOM 
viewer or stored in PACS manually. 

o Export to PACS - Exports a copy of all the data specified in the Export to DICOM Settings menu to 
a properly configured PACS server.  Configured servers will appear in a nested menu when 
selected.  

o Report to PDF - Exports a .pdf file containing the Report.  The Stress Report will also contain a 
copy of the Strain report.  Please refer to section 7.5.3 for more details regarding saving this file. 

o Image – Exports an image capture of the currently displayed image in the Analysis Window.  
Adjustments to the image created can be done through the Image and Video Settings option in 
the Setup Menu. 

o Video – Exports a video of the currently displayed slice in the Analysis Window.  Adjustments to 
the video created can be done through the Image and Video Settings option in the Setup Menu. 

• Rename Exam - Changes the default name of the exam displayed in the title bar, as well as the exam data 
folder created during the study. Note: Renaming an exam may not automatically update the file export 
path, double-check where data is being exported before doing so 

• Save Exam – Saves the current exam 

• Close Exam – Saves, then closes the current exam.  This clears all data currently loaded into MyoStrain. 

• Show Exam Licenses – Opens a pop-up menu which displays all active MyoStrain exam licenses. 

• Setup –  
o Settings – Opens the Settings submenu.  Please refer to section 3.6.3 for more detailed 

information. 
o Image and Video Settings – Opens the Image and Videos Settings submenu.  Please refer to 

section 3.6.4 for more information. 
o Export to DICOM Settings - Changes what information is converted to DICOM format when 

exporting data from MyoStrain. 
o Report Logo – Opens the Report Logo Selection submenu.  Please visit section 3.6.6 for more 

information.  
o Self-Check - Starts the Self-Check.  Please visit section 2.2.1 for more information. 

• Exit – Closes the program. 
 

NOTE: The exam data file is a single DICOM image which contains information related to exam inside the DICOM 
header for RIS and external PACS applications. 

 

3.6.1 OPEN ANONYMIZED MYO EXAM 
Datasets exported from MyoStrain using the Export Anonymous feature can be re-identified using the Open 
Anonymous feature.  Entering the anonymized patient’s name or ID in the associated field and pressing Search will 
display the associated patient information in the list.  Pressing on the Open button will open the original, non-
anonymized exam. 
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Figure 3-18: Open Anonymous Exam dialog box 

 

3.6.2 SHOW EXAM LICENSES 
In addition to the title bar, exam license information can also be viewed using this option from the File menu.   
 

 
Figure 3-19: Exam Licenses added to MyoStrain with their expirations 

 
Each software license runs independently, and MyoStrain will pull exams from the license code that is scheduled to 
expire first.  License codes which have expired will not be displayed in this list. 

 

3.6.3 SETTINGS MENU 
 
The Settings menu found in the File>Setup menu contains options that change how MyoStrain displays data.  
Pressing the Save button in the lower-right hand corner of the window will save any modifications made. 
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Figure 3-20: Settings menu found in MyoStrain’s File menu 

 

• Traditional Measurement Calculation – Enables or disables the “Traditional Measurements” section of 
the Strain report.  With this option off, End Diastolic meshes can no longer be drawn, and measurements 
such as “LVEF” and “LV Stroke Volume” will be disabled. 

o Use ED First – When enabled, MyoStrain will instead treat the first drawn mesh on each Long 
Axis slice as a Diastolic timeframe instead of a Systolic timeframe.  This is only available when 
Traditional Measurement Calculation is enabled. 

• Semi Auto Contouring – Enables or Disables Semi Auto Contouring.  Please refer to section 9 for more 
information. 

• Calculate RV Strain – Enables or Disables the RV feature of MyoStrain.  Contouring of the RV as well as RV 
measurements and displays are controlled by this option. 

• Display Scale – Enables or disables the measurement scale shown on the left-hand side of the Analysis 
Window 

• CSV Delimiter – Changes the output of .csv files created from Export Data options found in the Report 
and File>Export sections of the software. The default setting is Comma (,) 

• Exam Countdown Warning Number – If the software has less than the number of exams specified here 
available, warning messages will appear in yellow at the top of the program to alert all users (Figure 3-16 
and Figure 3-17). Setting these values to 0 will disable the warning. 

• Exam Countdown Risk Number – If the software has less than the number of exams specified here, this 
will override the Exam Countdown Warning Number and a warning will display in red at the top of the 
program. Setting these values to 0 will disable the risk message. 

• Compression Techniques – This changes how images sent from MyoStrain to a networked node are 
compressed.  Below are the options available and their associated transfer syntax (0002,0010) 

o JPEG Compression – 1.2.840.10008.1.2.4.50 (JPEGBaseline) 
o RLE Compression – 1.2.840.10008.1.2.5 (RLELossless) 
o No compression – 1.2.840.10008.1.2 (ImplicitVRLittleEndian) 

• Save – This closes the dialog box and saves all changes made. 
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3.6.4 IMAGE AND VIDEO SETTINGS 
The Image and Video Settings menu found in the File>Setup menu contains two menus of options that changes 
how MyoStrain exports videos and images for use outside of the application.  These settings can also be updated 
when exporting a video or screenshot by pressing the Show Advanced Settings button seen in Figure 3-22. 
 

 
Figure 3-21: Default Video/Screenshot export settings 

 

 
Figure 3-22: Video Export dialog box 

 

Exported videos and screenshots will be pulled from the currently displayed slice and timeframe respectively.  The 
General export settings change which UI elements will be added into the exported video/screenshot. 
 

• Display ES Mesh – When checked, the mesh drawn at End-Systole will be included in the output. 

• Display ED Mesh - When checked, the mesh drawn at End-Diastole will be included in the output. 

• Display Slice ID - Hides or displays the view information typically seen in the upper-left corner of the 
Analysis Window. 

• Display Timeframes - Enables or disables the phase/timeframe counter in the lower-left corner of the 
active slice. 

• Display Strain Palette – Hides or shows the strain scale and legend on the right side of the analysis 
window. 

• Display HR/BP - If performing a Stress exam, the Heart Rate and Blood Pressure can also be included or 
excluded from video output. 

 
The Override Application Settings button will enable or disable additional settings governed by MyoStrain.  The 
settings found below this checkbox are controlled by this option.  If not checked, the video will use the current 
settings MyoStrain is using at the time of export. 

• Background Color – sets the default background color of slices/images exported from MyoStrain. 

• Display Scale – This manages whether the measurement scale shown on the left side of the image will be 
included. 
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Under the Video tab, additional settings related to video export are also available.  These settings are related to 
encoder settings and frame rates of exported video. 
 

 
Figure 3-23: Video specific settings 

 

Video Encoding/Container provides 2 options for exporting video, Motion JPEG and Quick Time.   
 

3.6.5 EXPORT TO DICOM SETTINGS 
When exporting data to DICOM (either Local or PACS export), MyoStrain exports all data configured for export in 
the Export to DICOM Settings menu. 
 

 
 

• Images and PDF Report – Exports the formatted MyoStrain images and a copy of the PDF report when 
enabled. 

o Export Only Active Slices – When enabled, MyoStrain will only export the images used to 
generate the MyoStrain/MyoStress report at the end of analysis. 

• Report Data – This file contains exam data which enables cloud-based reporting capabilities (when 
coupled with MyoCloud technology). 

• Exam File – This is a copy of the exam file (.myo file) which has been formatted to fit in a DICOM image.  
This exam file can be read by MyoStrain if imported using the MyoWorklist feature. 

 

NOTE: When updating Export to DICOM Settings, it’s recommended to restart MyoStrain before exporting. 
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3.6.6 REPORT LOGO 
This section allows customization of the MyoStrain/MyoStress report.  Using the Browse button, a .jpg or .png logo 
can be imported and displayed in the upper-right corner of the report. 

 
Figure 3-24: Logo selected for use with the MyoStrain report 

After the logo has been uploaded, click the Save button to finalize the changes.  The logo will appear in the upper-
right corner on all pages of the report created at the end of MyoStrain analysis. 
 

NOTE: Images which do not fit the 250x60 pixel window will be resized proportionally to fit in the allotted window. 

 

 
Figure 3-25:Example image of the top of a MyoStrain report with a custom logo 

 VIEW MENU 
Next to the File menu at the top of the MyoStrain application, another menu labeled View is available. 
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Figure 3-26: All options of the View Menu displayed 

The View menu changes how images are displayed within MyoStrain’s Image List. 

• Thumbnail View – Contains options related to the Image List 
o Slices Order – Changes the order which images are displayed in the Image List. 

▪ Scanned - Displays images based on the on the order in which they were received by 
MyoStrain.  Earliest scans are displayed first. 

▪ BMA342 - Displays images in the following order: SAX Basal, SAX Mid, and SAX Apical, 
followed by LAX 3Ch, LAX 4Ch, and LAX 2Ch. Same order as displayed in the report. 

o Move Hidden Slices – Enabled by default, any image in the Image List which was manually 
hidden will be pushed to the end of the list.  When disabled, hidden images will be shown as 
greyed out. 

o Relative Planes - Enabled by default, this displays a black/orange line on each image in the Image 
List except for the currently selected slice.  These lines represent the imaging plane for each slice 
relative to the displayed slice in the Analysis Window. 

• Display Mode Settings – Opens the Display Mode Settings submenu.  Please refer to section 3.7.1 for 
more information. 

• Mesh Settings – Opens the Mesh Settings submenu.  Please refer to section 3.7.2 for more information. 
 

3.7.1 DISPLAY MODE SETTINGS 
The Display Mode Settings menu manages the default display of MyoStrain images in the Main Viewing Window, 
as well as in the Image List.  By default, MyoStrain launches in Light Mode (background of MyoStrain images are 
displayed in white).  In addition, the default windowing settings used for Brightness/Contrast adjustment can be 
set here as well. 

 
Figure 3-27: Display Mode Settings 

3.7.2 MESH SETTINGS 
The Mesh Settings menu allows the analyst to adjust aspects of the contours in MyoStrain, such as the mesh’s line 
thickness, coloring, and transparency.  To enable and/or change these settings, click on the Override Application 
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Settings checkbox, then click the Save button after making any changes.  Visual changes made to the mesh will 
apply to the Analysis Window, Image List, and any images exported from MyoStrain via DICOM or Video. 

 
Figure 3-28: Mesh Settings Menu 

 

 APPLICATION WINDOW ADJUSTMENT 
Portions of the MyoStrain application can be resized using the blue dividers seen throughout the program window.  
To increase or decrease the size of the Image List, Analysis Window, Report or Findings sections, simply left-click 
and hold the 5 dots seen in the middle of the divider (Figure 3-14), then drag the divider to the desired location.  
The Analysis Window will automatically increase the size of the images being viewed to fill in as much available 
space as possible.   
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Figure 3-29: Resizing the Analysis Window by decreasing the size of the Image List 
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4. IMAGE QUANTIFICATION 
 
This chapter provides a detailed walkthrough of the MyoStrain image quantification process.  The procedure for 
measuring and quantifying strain on each view of the myocardium is the same between Strain and Stress exams.  
Please refer to Sections 5 and 6 for Strain and Stress exam workflow respectively. 
 
Upon receiving images from the MR scanner, MyoStrain will display colorized images of the patient’s heart.  These 
colors (shown in the color scale Strain Legend) represent the amount of motion (strain) measured at any given 
point of the myocardium.  MyoStrain requires the user to identify the current view and apply a mesh to the left 
ventricle near end systole to accurately measure peak myocardial strain. Additionally, traditional measurements 
can also be gathered using the same tool. 
 

NOTE: When computing the strain after contouring the heart with a mesh, the strain measurements are restricted 
within the mesh and several timeframes before and after the meshed timeframe. Timeframes used in mesh 
calculation are underlined and highlighted in green in the lower-right corner of the Viewing Window. 

 

 DRAWING THE LV MESH (SHORT-AXIS VIEWS) 
 

 
Figure 4-1: MyoStrain Stress exam with three Short-Axis and three Long-Axis slices 

4 
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1. To draw a short-axis mesh, select one slice in the Image List which shows a Basal, Mid, or Apical view. 

2. In the upper-left hand corner of the Analysis Window, use the View Dropdown menu to select what view is 
currently displayed.  This will set the report to display the data gathered from the mesh in the correct location. 

 

Figure 4-2: Selecting the appropriate view from the View Dropdown 
 

3. In addition to selecting the proper view, enter the patient’s heartrate and blood pressure in the textboxes in 
the View Details (if not present).  Blood pressure should be reported as {Systolic/Diastolic}. 

4. If the image itself is too small, use the handlebars found on the right-hand side of the Analysis Menu and 
above the Image List to increase the size of the Analysis Window itself. 

4.1.1 EPICARDIAL CONTOUR 
 
1. Using either the CINE viewing buttons at the bottom of the image, your mouse scroll wheel, or the Slice 

Navigator, navigate through the slice to visually identify which image corresponds the most to end-systole.     

2. Starting at the RV insertion point (anteroseptal), use your mouse to make at least 4 points clockwise around 
the epicardial contour by left-clicking the myocardial border and ending on the Inferoseptal RV insertion point.  
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Figure 4-3: Beginning drawing the epicardial contour 

 
 

 
Figure 4-4: Double-clicking here will complete the epicardial contour 

 

Start  

End  
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3. Double-click the last point of the contour near the starting contour point to complete the drawing. 
 

4. A contour polygon will be created for the epicardium defining several points.    The first point created will mark 
the RV connection point.   
 

 
Figure 4-5: Completed epicardial contour 

 

NOTE: Meshes can also be applied by tracing the epicardium while holding down the left-mouse button.  Releasing 
the left-mouse button will complete the drawing.   

 
 
 

4.1.2 LV MESH COMPLETION (ENDOCARDIAL CONTOUR) 
Using the same drawing method, define the endocardial contour.  Since the epicardial contour marks the position 
of relevant anatomical markers, the endocardial contour can be applied beginning at any point.  
 
 
 

NOTE: Papillary muscles should be omitted from any contours.   
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Figure 4-6: Completing the endocardial contour and the finished mesh with RV marker 

After the endocardial contour has been added to the mesh, the MyoStrain software will zoom into the image and 
improve visibility.  Ensure that the corresponding Short-Axis model in the Measures section is updated after 
finishing the mesh. 
 

 

4.1.3 ADJUSTING THE MESH (SHORT-AXIS VIEW) 
Once the mesh is applied, changes or updates to the mesh may be required.  Common changes may be to adjust 
the location of the RV insertion point, or to adjust a minor region of an epicardial contour. 

1. The blue arrow should be marking the RV insertion point (anteroseptal, outside of RV blood pool) . 
 

2. You can rotate the mesh by clicking and holding the insertion point arrow and moving it to its appropriate 
location. 
 

3.  If any individual points need to be moved to better fit the myocardium, use your left-mouse button to 
reposition points on the mesh. 
 

 
Figure 4-7: Example of a single point mesh correction 
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4. If a large section of the mesh’s epicardial or endocardial contour points need to be redrawn, you may redraw a 
portion of the contour by left-clicking periodically near the existing mesh, then double-clicking to complete.  
Additionally, clicking and holding the left-mouse button will allow a contour to be traced onto the 
myocardium. The mesh will incorporate this new drawing into the existing mesh. (Figure 4-8). 

5. If the mesh has been placed in an incorrect location after image rotation, the red dot shown in the center of 
the LV blood pool can be used to drag the mesh into a different location. 

6. The Undo, Redo, and Reset buttons found in the Slice submenu will undo the most recent mesh action, redo 
the most recent mesh action, and reset the slice to its default state respectively. 
 
 
 

 
Figure 4-8: Mesh adjustment by drawing a new contour freehanded 

 

4.1.4 RV QUANTIFICATION (SA BASAL AND SA MID) 
After completing the LV mesh, the RV can be measured by adding additional contours to the existing LV mesh.  
Please note that Short-Axis RV quantification can only be performed on the Basal and Midcavity slices of the stack.   
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Figure 4-9: Clicking on the RV button after completing the LV mesh will enable RV contouring 

First, enable the RV analysis tool by pressing the RV button at the top of the Analysis Menu (Figure 4-9). Then, 
starting at the RV anterior junction, use your mouse to identify the epicardial boundary of the RV wall.  Left-
clicking first on the RV anterior junction, click multiple times on the epicardial wall moving counter-clockwise, 
making the last point touch on the RV Inferoseptal junction.  Double-clicking on the RV Inferoseptal junction will 
complete the contour on the RV and will attach itself to the existing epicardial LV contour.  
 

 
Figure 4-10: Beginning the epicardial RV contour 

 



 

 
_________________________________________________________________________________ 

User’s Manual LBL-1015 Rev G Confidential Page 49 

 

 
Figure 4-11: Double-clicking here will complete the epicardial RV contour 

 

NOTE: You can also click and hold down the left-mouse button to draw a contour by tracing the epicardium or 
endocardium.   

 

 
Figure 4-12: Completed RV epicardial contour 

 
Using the same method as before, define the endocardial contour.  Once complete, the RV mesh will be fully 
attached to the existing LV mesh, and measurements from the RV will be displayed in the Report. 
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Figure 4-13: Defining the endocardial contour for a complete RV mesh 

 

If adjustments need to be made to the mesh during or after completion, click the Undo button to erase the 
contour or mesh to try again. 

 DRAWING THE MESH (LONG-AXIS VIEWS) 
 

1. To draw a long-axis mesh, select one slice in the Image List which shows a 2-chamber, 3-chamber, or 4-
chamber view of the myocardium. 

2. In the upper-left hand corner of the Analysis Window, use the View Dropdown menu to select what view is 
currently displayed.  This will set the report to display the data gathered from the mesh in the correct location. 

 
Figure 4-14: Selecting a Long-Axis view from the View Dropdown menu 
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3. In the upper-left hand corner of the Analysis Window, enter the patient’s heartrate and blood pressure in the 
textboxes below the view selector (Stress exams only).  Blood pressure should be reported as 
{Systolic/Diastolic}. 

4.2.1 EPICARDIAL AND ENDOCARDIAL LV CONTOURS 
 
1. Using the video playback buttons at the bottom of the image, your scroll wheel, or the Slice Navigator, look 

through the slice to visually identify which image displays best represents end-systole.     
 
 
2. Starting on either side of the LV, use your mouse to make points around the epicardial contour by left-clicking 

periodically on the image.  A minimum of 4 points must be used to draw this contour. 
 

 
Figure 4-15: Beginning the epicardial contour 
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Figure 4-16: Double-clicking here will finish the epicardial contour 

 
 

3. Double-click on the last point. 
 

4. A mesh contour will be created for the epicardium.  Ensure that the red circle is at the apical point of the LV.  If 
this circle is not correctly positioned, use the left-mouse button to drag it into the appropriate location. 
 

 
Figure 4-17: Completed epicardial contour with correct apical marker 
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5. Using the same method, draw the endocardial contour (avoiding the papillary muscles).  Upon completion, the 

image will rotate to match the models shown in the Measures section.  Additionally, a red dot will appear near 
the middle of the LV blood pool. 
 

  
Figure 4-18: A completed epicardial contour with apical marker 

 
 

 

4.2.2 ADJUSTING THE MESH (LONG-AXIS VIEWS) 

After completing the mesh, adjustments may need to be made to accurately represent the myocardium. Common 
adjustments may involve redrawing one section of the contour or resetting the reference point shown on the 
image.  

1. Depending on where the final contour drawing of the mesh began will determine where the reference 
marker is shown on the image.  If this reference marker is incorrect, left-clicking on these letters will 
switch the reference point to the corresponding side. 

 

• BAL – Basal Anterolateral (4ch) 

• BIS – Basal Inferoseptal (4ch) 

• BAS – Basal Anteroseptal (3ch) 

• BIL – Basal Inferolateral (3ch) 

• BA – Basal Anterior (2ch) 

• BI – Basal Inferior (2ch) 
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Figure 4-19: The mouse cursor will change when hovering over the reference point.  Left-clicking will flip the image and change 

the reference marker 

 
2. If any individual points need to be moved to better fit the myocardium, use your left-mouse button to 

reposition points on the mesh. 
 

 
Figure 4-20: Example of a single point mesh correction 

 
3. If a large section of the mesh’s epicardial or endocardial contour points need to be redrawn, you may redraw a 

portion of the contour by left-clicking periodically near the existing mesh.  Double-clicking at the end of this 
correction will signal the completion of the new contour and will be incorporated into the existing mesh 
(Figure 4-21). 

4. If the mesh has been placed in an incorrect location after image rotation, the red dot shown in the center of 
the LV blood pool can be used to drag the mesh into a different location. 

5. If either the endocardial or epicardial contour needs to be moved, clicking and dragging any of the lines of the 
contour will allow relocation of the drawing. 

6. The Undo, Redo, and Reset buttons found in the Slice submenu will undo the most recent mesh action, redo 
the most recent mesh action, and reset the slice to its default state respectively. 
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Figure 4-21: Modifying the mesh by redrawing a contour section using the freehand method 

 

After drawing and correcting the mesh, verify that the information displayed in the Circumferential Strain 
subsection of Measures is reflecting the data shown in the Analysis Window.  

4.2.3 LONG-AXIS RV QUANTIFICATION 
  
After completing the LV mesh, the RV can be measured by adding additional contours to the existing LV mesh.  
Please note that Long-Axis RV quantification can only be performed on the 3 and 4-chamber views of the LV.  Make 
sure the RV button is selected (Figure 4-22) in the Analysis Menu before applying an RV contour. 
 

NOTE: You can also click and hold down the left-mouse button to draw a contour by tracing the epicardium or 
endocardium.   

 
NOTE: Applying an RV contour to an LV contour may automatically flip the LV image to adjust Reference Points.  
Ensure the anatomy matches the Reference Point before continuing.   
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Figure 4-22: Clicking on the RV button after completing the LV mesh will enable RV contouring 

 

 

4.2.3.1.1 4-CHAMBER RV MESH 
Beginning at the valve plane, trace the epicardial contour by left-clicking periodically along the epicardium. 
 

 
Figure 4-23: Beginning RV contour on 4Ch image 
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To finalize the first contour, double-click the last point once the apex of the RV has been reached.  The contour will 
automatically attach itself to the existing LV mesh. 
 

 
Figure 4-24: Completion of the epicardial RV contour 

 
After completing the epicardial contour, use the same method to define the endocardial contour.   
 

 
Figure 4-25: Completion of the 4Ch RV contour 

 

NOTE: You can also click and hold down the left-mouse button to draw a contour by tracing the epicardium or 
endocardium.   
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4.2.3.1.2 3-CHAMBER LONG-AXIS MESH 

 
Figure 4-26: 3Ch view with RV button selected 

 
Beginning at either the base of the RV or the top of the Basal Anteroseptal region of the LV, trace the epicardial 
contour by left-clicking periodically around the epicardium. 
 

 
Figure 4-27: Beginning the epicardial RV contour at the mid anterior region 

 
After reaching the mid-anterior region of the heart where the LV and RV re-connect, double-click to complete the 
contour. 
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Figure 4-28: Completion of the epicardial RV contour 

 

NOTE: Make sure the RV contour connects to the epicardial wall of the LV contour opposite of the LV endocardial 
contour.  See Figure 4-29 for an example.   

 

 
Figure 4-29: An example of an improperly drawn RV contour 

 
After tracing the epicardium, repeat the same process for the endocardial contour.   
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Figure 4-30: Endocardial contour drawn for 3Ch RV 

 
After completing the RV contour, verify the analysis results are being displayed correctly in the Measurements 
field of the Report. 
 

4.2.4 END DIASTOLIC MESH AND TRADITIONAL MEASURES 
 
In addition to calculating peak systolic strain, MyoStrain calculates traditional measures such as LVEF.  These 
measurements are calculated based on the Long Axis images and should be performed for each Long Axis view in 
the study.  Make sure the Ejection Fraction button in the Analysis Menu is checked before continuing. 
 
 

 

RV measurements are not evaluated on Diastolic meshes.     

 
To calculate traditional measures, first visually identify the frame best representing End-Diastole.  This can be done 
using the Slice Navigator, your mouse’s scroll wheel, or the CINE viewing buttons at the bottom of the Analysis 
Window.   
 



 

 
_________________________________________________________________________________ 

User’s Manual LBL-1015 Rev G Confidential Page 61 

 

 
Figure 4-31: End-Diastolic meshed and viewed in the Slice Navigator 

 

NOTE: The End-Diastolic timeframe is usually either the first or last image of a series.  It is important to verify the 

timeframe used is the closest to End-Diastole 

After choosing the End-Diastolic timeframe, using the same mesh application methods used in section 4.2.1, apply 
both an endocardial and epicardial contour to this image.   
 
 

 
Figure 4-32: End-Diastolic timeframe meshed with traditional measurements displayed 

 

After both the systolic and diastolic frames have been meshed, their locations will be marked in the Slice Navigator 
(Diastole in green, Systole in orange) and their measurements will be shown in the Measures section. 
 

NOTE: Traditional measurements will only be pulled from the timeframes marked in the Slice Navigator.  Use the 

Set as ES and Set as ED buttons to re-identify these timeframes if a new time is used in the future. 
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5. STRAIN EXAM REPORTING 
 
Refer to this chapter of the MyoStrain User’s Manual to understand the workflow of a MyoStrain Exam.  This 

chapter should be followed once a patient is ready to be scanned.   
 

 MYOSTRAIN® TEST PROCEDURE 
The MyoStrain Test procedure is a simple, fast, and non-invasive process.  Images acquired from the scanner 
should automatically be imported into the application.  This procedure assumes a technician is operating the 
MRI scanner, a patient is ready to be scanned, and the MyoWorklist is running in Single Mode (please refer 
to chapter 10 for more information about the MyoWorklist).  The below sequence of events is typical for a 
Strain exam: 

1. Launch the MyoStrain Strain exam 

2. Enter relevant patient information in Analysis Window 

3. Select one slice from Image List 

4. Quantify slice 

5. Repeat steps 3-4 for each slice out of six total views. 

6. Finalize report and export results 

 

 STARTING THE STRAIN EXAM 
Upon launching the MyoStrain application, or by selecting New from the File menu, the software will display a 
dialog box labeled “Select Your Exam”.  Click on the top button labeled MyoStrain® to launch the MyoStrain Strain 
exam. 
 

NOTE: Exam Credits will not be used until an image has been received by the software in an analysis mode.   
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Figure 5-1: Exam Selection Screen 

 
 

 RECEIVE IMAGES 
After selecting MyoStrain from the Mode Selection tab found above the Report section, executing the MyoStrain 
image sequence on the MRI scanner will send images to the workstation.  This action will consume an exam credit 
and cannot be reversed. 
 

 
Figure 5-2: MyoStrain in RV Strain mode receiving images 

 
After all six views from the MyoStrain pulse sequence have been received by the MyoStrain application, image 
review and quantification can begin. 
 

 IMAGE REVIEW AND ANALYSIS 
Once all images from the scanner have been transmitted to the MyoStrain software, review each image to ensure 
good image quality is present.  If for some reason the image quality is poor or there was an issue during 
acquisition, refer to section 5.4.1 to reject a scan.  A rescan can be performed without consuming an exam credit 
provided the exam is not closed during the session. 
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If the image quality is good and strain data is clearly visible, proceed to quantify all six slices.  Please refer to 
chapter 4 for detailed instructions on image quantification. 
 

5.4.1 SIGNAL VS NOISE IN IMAGE ANALYSIS 
In some situations, applying a mesh to a slice will not result in all segments being displayed in the Report Section.  
If the mesh encounters a region where more than 50% the strain data is determined to be noise, the 
Measurements section will display that region as “NA”.  “NA” regions are displayed with black hatchmarks, which 
are different from un-analyzed slices, which are shown in grey.  Both unanalyzed segments, along with “noisy” 
segments, do not provide strain data towards the MyoHealth™ score (for LV segments) or to global strain 
measurements. 
 

 
Figure 5-3: Basal Slice analyzed showing the RV Anterior as “NA” 

 

5.4.2 REJECTION OF IMAGES 
During the post-processing analysis, any number of issues may arise.  This may include patient movement during 
acquisition, poor image quality, or any number of minor issues.  At any point during the analysis, clicking Reject 
(Figure 5-3) in the upper-right corner of the Image List will remove those images from the scan. 
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Figure 5-4: Reject button shown in Image List 

 

 

Image rejection will irreversibly remove images from the current exam.  Images will need to be re-
sent to the workstation if this occurs.   

 

5.4.3 HIDING IMAGES  
If multiple slices of the same view have been acquired, it may prove useful to move some slices out of the way to 
make sure they are not analyzed.  Right-clicking any image in the Image List will bring up a context menu; selecting 
Hide will grey out the slice and move it to the far-right side of the image list.  It can be unhidden by right-clicking 
the greyed-out slice and selecting Unhide. 
 

 
Figure 5-5: Hiding and Unhiding an image in the Image List 

 REPORTING AND EXPORTING DATA 
After quantifying all six slices of the current patient scan, the analysis portion of the scan is complete and the 

patient may be removed from the scanner.  It is recommended to save the quantified exam data before continuing 

to the Report Section to export the Strain Report and exam data. 

To save the exam, select Save from the File menu. 
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Figure 5-6: RV Strain Report section 

 

Please refer to chapter 7 for more information on the Report Viewer and exporting data from the MyoStrain 

application.  
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6. STRESS EXAM REPORTING 
 
This chapter introduces the MyoStrain Stress Test post-processing analysis.  Refer to this chapter of the MyoStrain 
User’s Manual to understand the workflow of a MyoStrain Stress Exam.  This chapter should be followed once a 
patient is prepped for a stress examination.   
 

 MYOSTRESS® TEST PROCEDURE 
The MyoStrain Stress test is a simple and fast cardiac stress test which can be administered in a very short span of 
time.  Images acquired from the scanner should automatically be imported into the MyoStrain Stress Test 
application.  This process assumes an MRI technician is operating the scanner, a patient has been prepared for a 
stress test scan, and the MyoWorklist is running in Single Mode (please refer to chapter 10 for more information 
about the MyoWorklist).  The below sequence of events is typical for a Stress exam: 

 

1. Launch MyoStrain in MyoStress Mode. 

2. Enter relevant patient information in Analysis Window 

3. Set current stress phase for incoming images 

4. Select one slice from Image List in current stress level 

5. Quantify the current slice 

6. Repeat steps 4-5 for each image in current stress phase 

7. Advance to next stress phase, then repeat steps 2-6. 

8. After all stress phases have been completed, finalize the report and export the results. 

 

 STARTING THE STRESS EXAM 
Upon launching the MyoStrain application, or by selecting New from the File menu, the software will display a 
dialog box labeled “Select Your Exam”.  Click on the button labeled MyoStress® to launch the MyoStrain Stress 
exam. 
 

NOTE: Exam Credits will not be used until an image has been received by the software in this analysis mode.   
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Figure 6-1: Exam Selection Screen 

 

 RECEIVE IMAGES (REST PHASE) 
After selecting MyoStress® from the Mode Selection tab found above the Report section, executing the MyoStrain 
image sequence on the MRI scanner will send images to the workstation.  This action will consume an exam credit 
and cannot be reversed. 
 

  
Figure 6-2: MyoStrain application in Stress mode receiving images 

 
After all six views from the MyoStrain pulse sequence at the patient’s resting state have been received by the 
MyoStrain application, image review and quantification can begin.  Images received will be organized based on the 
order which they were received and labeled as “Acquisition #”.  Ensure that the dropdown menu in the upper-right 
hand corner of the Image List is set to read “Rest” as show in (Figure 6-3). 
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Figure 6-3: Image list with Acquisition 1 set to “Rest” 

 

 IMAGE REVIEW AND ANALYSIS 
Once all images from the scanner for the rest stage have been transmitted to the MyoStrain software, review each 
image to ensure good image quality is present.  If for some reason the image quality is poor or there was an issue 
during acquisition, refer to (6.3.1) to reject a scan.  A rescan can be performed without consuming an exam credit 
if the exam is not closed during the session. 
 
If the image quality is good and the strain data is clearly visible, proceed to quantify all six slices.  Please refer to 
chapter 4 for detailed instructions on image quantification. 
 

 
Traditional measurements are only calculated on the Rest phase.   

 

6.4.1 SIGNAL VS NOISE IN IMAGE ANALYSIS 
In some situations, applying a mesh to a slice will not result in all segments being displayed in the Report Section.  
If the mesh encounters a region where more than 50% the strain data is determined to be noise, the 
Measurements section will display that region as “NA”.  “NA” regions are displayed with black hatchmarks, which 
are different from un-analyzed slices, which are shown in grey.  Both unanalyzed segments, along with “noisy” 
segments, do not provide strain data towards the MyoHealth™ score (for LV segments) or to global strain 
measurements. 
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Figure 6-4: Basal Slice analyzed showing the RV Anterior as “NA” 

 
 

6.4.2 REJECTION OF IMAGES 
During the post-processing analysis, any number of issues may arise.  This may include patient movement during 
acquisition, poor image quality, or any number of minor issues.  At any point during the analysis, selecting Reject 
from the drop-down menu in the upper-right corner of the Image List will remove those images from the scan. 

 
Figure 6-5: Selecting this option will remove any images and meshes from this acquisition stage from the analysis 

 

 

Image rejection will irreversibly remove images from the current exam.  Images will need to be re-
sent to the workstation if this occurs.   
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6.4.3 HIDING IMAGES  
If multiple slices of the same view have been acquired, it may prove useful to move some slices out of the way to 
make sure they are not analyzed.  Right-clicking any image in the Image List will bring up a context menu; selecting 
Hide will grey out the slice and move it to the far-right side of the image list.  It can be unhidden by right-clicking 
the greyed-out slice and selecting Unhide. 
 

 
Figure 6-6: Hiding and Unhiding an image in the Image List 

 
Additionally, the entire stage can be hidden as well by selecting Hide from the stage drop-down menu. 
 

 
Figure 6-7: Hiding an entire stage moves it to the bottom of the list 

 IMAGE ACQUISITION (STRESS PHASES) 
After the Rest phase images have been received from the scanner, a timer will display in the Stage section of the 
Analysis Window.  This timer shows how much time must pass before the software will recognize a new set of 
images being received as a new stress phase.   
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Figure 6-8: Stress Phase timer 

 
Once the stressor has been administered to the patient, the user must allow the timer to expire before beginning 

the next series of image acquisitions.  If images need to be acquired before this timer has expired, pressing the 

Next Stage button will override the timer and manually begin a new stress phase.  Any images received by the 

MyoStrain application after this point will be added to the next Acquisition series in the Image List. 

 

Figure 6-9: Images acquired at new acquisition number 

 
Use the dropdown menu on this new acquisition stage to identify this image series’ appropriate stress 
phase/stressor. 
 
 

 

Please refer to your site’s stress test procedure for specific instructions regarding testing procedure 
and stress agent usage. 
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 IMAGE PROCESSING (STRESS PHASES) 
After receiving the next stage of images from a new stress phase, the behavior of the Analysis Window will change 
and display two different sets of images. 
 

 
Figure 6-10: Analysis Windows showing both Rest and with 10 Mics Dobutamine  

 

Both Analysis Windows have the same behavior as before, except that the window must be highlighted (or active) 
before interacting with it.  The Rest images will always be shown in the left-hand window to allow comparison to a 
later stress phase in the right-hand window.   
 

NOTE: Brightness/Contrast adjustments will only affect views contained in the highlighted image’s series. 

 

 REPORTING AND EXPORTING DATA 
After quantifying each slice from all stress phases of the current test, the analysis portion of the scan is complete, 

and the patient may be removed from the scanner.  It is recommended to save the quantified exam data before 

continuing to the Report Section to export the Stress Report and exam data. 

To save the exam, select Save from the File menu. 
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Figure 6-11: Stress Report section showing reduction of strain during stress 

 

Please refer to chapter 7 for more information on the Report Viewer and exportation of data from the MyoStrain 

application.  
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7. REPORT VIEWER AND EXPORT 
The Report Page automatically composes a report from the various sources of information that are obtained during 
the analysis. This report can then be uploaded exported as a PDF document to be later archived or printed out for 
later use. 

 REPORT VIEWER OVERVIEW 
During a Strain or Stress exam, the Report Viewer will display the corresponding report measurements during the 
exam.   
 

NOTE: Stress exams generate a resting Strain report in addition to the Stress report.  The Strain report can be 
viewed by clicking the Strain button at the top of the Report (Figure 7-1 A). 

 
When images are imported into a new exam, patient information is automatically imported into the report under 
the Patient tab (Figure 7-1 B).  The Measures section (Figure 7-1 C) is automatically populated with the strain data 
gathered from the meshes drawn during the exam.  The Findings section (Figure 7-1 D) is a blank text field which 
can be used to add any additional information gathered during the exam.   

 

 
Figure 7-1: Report Section of the MyoStrain Stress Test 
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Figure 7-2: Report Section of the Strain Test 

 

 PATIENT INFORMATION (B) 
 

 
Figure 7-3: Sample Patient Data 

 
If any information was not present in the medical images sent to the workstation, this data may be manually 
updated by typing the correct information into each text box.  You may tab between sections to speed up the 
entry process. 
 
 

 MEASURES (C) 
This section displays all available measurements gathered from the current study using a standardized AHA model 
(see section11.3).  The measurements and models shown in this section are based on the type of exam currently 
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being performed.  Traditional measurements and index values can be found above the AHA models in the 
Measurements section.  Strain measurements, both circumferential and longitudinal, are also displayed with strain 
ranges shown.  Information regarding the calculation of index ranges and normal can be found in section 11.4. 
 

 
Figure 7-4: Example Stress exam with one stage of stress agent 

 
MyoStress tests will display both resting strain and the strain calculated at the highest level of stress.  The 
Measurements section from MyoStrain exams will display resting strain, as well as global circumferential and 
longitudinal strain.  Only slices which are marked with a green dot in the Image List have their information 
displayed here. 
 
 

 
Figure 7-5: Example Strain exam with all 6 views quantified 

 
The measures provided in the Measurements pane are calculated as follows: 
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• Global MyoStrain® Measurements: 
o MyoStrain (GLS) LV – Average percentage of peak strain calculated from all Short-Axis LV slices. 

(Previously LV Global Longitudinal Strain (GLS)) 
o MyoStrain (GCS) LV – Average percentage of peak strain calculated from all Long-Axis LV slices. 

(Previously LV Global Circumferential Strain (GCS)) 
o MyoStrain (GLS) RV – Average percentage of peak strain calculated from all Short-Axis RV views. 

(Previously RV Global Longitudinal Strain (GLS)) 
o MyoStrain (GCS) RV – Average percentage of peak strain calculated from all Long-Axis RV 

views.(Previously RV Global Circumferential Strain (GCS)) 

• LV Dysfunctional Segments 
o Number of  Segments < -10% –  This displays the total number of segments calculated by 

MyoStrain to have above -10% strain. 
o Number of Segments > -17% – This displays the total number of segments calculated by 

MyoStrain to have above -17% strain. 

• Traditional Measurements 
o LVEF – Percentage of blood emptied from the left ventricle during systole. 
o LV Mass – Mass of the LV calculated by the Diastolic timeframes contoured on Long-Axis images. 
o LVED Volume – Volume (in mL) of blood measured in the LV at Diastole measured across all 

Long-Axis images. 
o LVES Volume – Volume (in mL) of blood measured in the LV at Systole measured across all Long-

Axis images. 
o LV Stroke Volume – Difference of volume (in mL) between the LVED Volume and LVES Volume. 

• Vitals (Stress Exam) 
o Heart Rate – BPM of the patient.  The heart rate displayed in the Measurements pane is pulled 

from the first image received as part of that stage. 
o Blood Pressure – Displayed as Systolic/Diastolic, the blood pressure displayed is pulled from the 

first image received as part of the current stage.  This can be overwritten from the Analysis 
Window. 

o Stress Agent - Displays the greatest stage of stressor applied to the patient. 
 

7.3.1 MYOHEALTH™ MEASUREMENT 
MyoHealth™ is a derived measurement which displays the percentage of segments below -17% strain compared to 

the total number of LV segments analyzed.  This measurement is displayed only if at least 30 of the 37 segments 
required for a full MyoStrain exam are analyzed.  RV calculations are not included in this assessment.  A formula 
for calculating MyoHealth is described below.  
 
 
MyoHealth = [(# of LV Segments Above -17%) / (# of LV Segments Analyzed)] * 100 

 
7.3.2 STRAIN LEGEND 
During the MyoStrain analysis, each mesh applied to the dataset will populate the appropriate model in the 
Measurements section.   The color legend below provides a basic guide to the meaning of each color.  
 

 

 
Figure 7-6: Color Legend for Strain 

 
For more information regarding the Strain Legend, please refer to Section 11.2. 
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In the Change section of the MyoStrain Stress Report, a different color scale is used.  This section displays the 
percentage change between the Rest images and the most recent Stress acquisition.   
 

 
Figure 7-7: Color Legend for Change 

 

Areas which were identified has having marked improvement under stress are displayed in blue, where regions 
that had reduced function are shown in red. 
 

 
Figure 7-8: Sample Stress report with multiple regions indicated as having reduced strain under stress 

 
In the example above, there are multiple regions which expressed a significant decline in function between Rest 
and Stress measured with Dobutamine administered.  This would potentially indicate an issue with the 
myocardium in this case. 
 
Additionally, strain values can be displayed during a Stress exam by clicking the Strain Numbers (Figure 7-9) button 
found in the upper-right hand corner of the Measurements window in the Stress report. 
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Figure 7-9: Stress Report measurements with Strain Numbers option active 

 
 

 FINDINGS (D)  
The Findings section is the last section to be filled out before completing the exam and exporting data for later 
use.  Any text data can be added to this section and will be displayed at the bottom of the final report. 
 

 
Figure 7-10: Findings section (Stress Test) 

 
After the Findings section has been completed (or left blank, the field is optional), proceed to the bottom of the 
Report section to export the data.   
 

NOTE: Saving after finalizing the Report section is a good idea before exporting exam results. 

 
 

 IMAGE AND REPORT EXPORT (E) 
 

 
Figure 7-11: Export Options 

 
After the report section has been completed, data gathered from the exam needs to be exported for later use.  
Depending on the analysis workflow, different actions will be required to satisfy reporting requirements and 
should be identified before continuing. 
 

NOTE: Please contact your Myocardial Solutions Representative for more information regarding reporting 
requirements. 

 

• Export Anonymous – Exports an anonymized copy of all available measurements, reports, and images 
from the current analysis.   

• Export Data – Exports a .csv or .xml file containing all raw strain values from all stress levels recorded 
during the exam.  Please refer to section 7.5.3 for more details regarding saving this file. 
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• Export to PACS -  Pushes a copy of the final report, an exam data file, and the analyzed MyoStrain images 
(with meshes) to the PACS server (if configured to do so).  This is done by taking a screenshot of the 
report and converting it into a DICOM image. Data selected for export can be configured in the 
File>Setup>Export to DICOM Settings menu. 

• Report to PDF – Exports a .pdf file containing the Report.  The Stress Report will also contain a copy of the 
Strain report.  Please refer to section 7.5.3 for more details regarding saving this file. 

 
 
 
 

7.5.1 ANONYMOUS EXPORT 
 

 
Figure 7-12: Export Anonymous dialog box 

 
Export Anonymous is an additional export option available within MyoStrain. Clicking this button will bring up a 
dialog box with a few options: 
 

A. Choose Folder - This field will display the file path where all exam data will be exported to.  A folder will 
be created in this directory and data copied into it.  The ellipsis button will allow the user to identify a 
new file path for export. 

B. Folder Name – This text box contains the folder name which will be created in the Choose Folder path.  
This field may not contain the following characters: ( * . “ / \ ] [ : ; | = , ) 

C. Patient Name – This will overwrite the name of the exported patient with the contents of this text box. 
D. Patient ID – This will overwrite the Patient ID of the exported patient with the contents of this text box. 
E. Save – This begins the export process. 
F. Cancel – This cancels the export process. 

 

7.5.2 PACS EXPORT 
After pressing the Export to PACS button, the MyoStrain application ask to confirm where to export the data (). 
After confirming the export location, MyoStrain will begin processing and sending images back to PACS (Picture 
Archiving and Communications System) for storage purposes.  A window will appear in the background of the 
MyoStrain application called the “Dicomizer”. 
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Figure 7-13: Clicking the Export to PACS button will display a PACS selection screen 

 
The Dicomizer will display the current progress of images currently being uploaded.  The MyoStrain application and 
the progress window must remain open while images are still being processed. Closing the application or the 
Dicomizer window will cancel the upload. 
 

 
Figure 7-14: Progress window for background image archival 

 
 

7.5.3 LOCAL EXPORT 
 
Clicking on either the Export Data or Report to PDF buttons at the bottom of the Report section will launch a 
dialog box (Figure 7-14, Figure 7-16) asking where to save data.  The Export Data dialog box asks whether the data 
should be saved as a .csv or .xml document. 
 

 
Figure 7-15: Export Data Dialog Box 
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Figure 7-16: Save Report Dialog Box 

 
Using this window, navigate to the location designated by your organization to save this report with the Choose 
Folder (ellipsis) button, then click Save.  The user may provide a unique name to the report by changing the File 
Name text. 
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8. PREVIEW MODE (IMAGE PLANING) 
Preview Mode is an additional operation mode available within MyoStrain.  It is only available when launching 
either a Stress or Strain examination from the Worklist operating in Multi Mode. 
 
In the Worklist, next to the New Exam button, a Preview button is available.  Clicking on this button will launch the 
Preview window. 
 

 
Figure 8-1: Worklist running with several datasets ready for Preview or analysis 

 
Before any actual analysis begins, it may be useful to use Preview mode.  This allows MyoStrain to display images 
without consuming an exam credit.  Using this feature is useful to ensure the scanner is looking in the correct 
location and the myocardium is being imaged properly before using an exam credit. 
 
 

 
Figure 8-2: Preview with 6 slices available, 2CH view currently selected 
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NOTE: Any images imported using Preview mode will not consume an exam credit.  The images shown cannot be 
quantified. 

 
The Preview window displays 3 different views at the top of the screen of the SENC images pulled from the 
scanner.  Clicking on any of the views in the Image List at the bottom of the Preview window will display that slice 
in the following 3 views: 
 

• SENC – These are the unencoded SENC images pulled from the scanner.  The images when played back 
shift between the High-Tune and Low-Tune images unique to the SENC pulse sequence. 

• Anatomy – These are the SENC images recombined without applying the Strain map. 
 

 
Figure 8-3: Sample 2CH image displaying the raw SENC images from the scanner 

 
Using either the mouse scroll wheel, the arrow keys on the keyboard, or the CINE playback buttons found at the 
bottom of each of the Analysis Windows, play through each slice to ensure no artifacts or image abnormalities are 
present.  The Preview window will also display all stages of stress acquired as part of the analysis as well. 
 
After reviewing the images, close the Preview window to return to the MyoWorklist.   
 
 
  



 

 
_________________________________________________________________________________ 

User’s Manual LBL-1015 Rev G Confidential Page 86 

 

 

9. SEMI-AUTOMATIC CONTOURING WORKFLOW 
Semi-Automatic Contouring is an optional feature which automates most of the analysis process.  Using this mode 
allows the software to automatically apply a mesh to the image being analyzed.  This feature can either be enabled 
or disabled by default.  Any meshes applied using Semi-Automatic Contouring must be reviewed for accuracy before 
completion.  Methodology for sending images to the workstation is identical with or without automatic contouring 
active. 
 
 
The Semi-Automatic Contouring feature is available for use in both the Strain and Stress examination modes.  The 
ability to enable and disable this functionality is controlled by the Semi Auto Contouring button in the Settings 
menu found under File>Setup in the title bar.  This option will only take effect if there are no images currently 
loaded into the software.  Restarting the MyoStrain program or beginning a new exam will enable the Semi-
Automatic Contouring. 
 

 
Figure 9-1: Semi Auto Contouring button checked 

 
When Semi Auto Contouring is enabled, MyoStrain will attempt to apply a LV mesh for all Long-Axis and Short-Axis 
images near End-Systole upon image import.  Additionally, if Traditional Measurements are enabled, Semi-Auto 
Contouring will also attempt to identify the End-Diastolic timeframe for Long-Axis images and apply a LV mesh for 
that image as well.  All images, regardless of origin, will attempt to be semi-automatically contoured with this 
feature enabled.  If MyoStrain is unable to confidently apply a contour to the image, no mesh will be drawn. 
 

NOTE: Semi-Automatic Contouring does not perform RV quantification. 
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Figure 9-2: MyoStrain in process of receiving and analyzing Strain images 

  
Immediately upon receiving images, either by creating a New Exam from Folder, pushed from the MyoWorklist or 
sent directly from the scanner, MyoStrain will immediately begin analyzing images.  As soon as an image has been 
processed/analyzed, it will appear in the Image List.  The lower-left region of the application will display progress 
messages when importing/analyzing images and will read Ready when the current series of images has been 
processed.  All meshes created by MyoStrain through the Semi Auto Contouring tool will display as orange and will 
not display any strain information in the report. 
 

 
Figure 9-3: All images imported and analyzed, no measurements displayed in report 

 

NOTE: If images are being sent directly from the scanner, either the New Stage or Contour Stage button in the 
Analysis Menu must be pressed before Semi Auto Contouring will begin analysis.   
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 IMAGE REVIEW AND ADJUSTMENT 
After the software has imported images and performed the Semi-Automatic Contouring, it is imperative to review 

all images for completeness and for accuracy.  Each thumbnail in the Image List will display a suggested mesh (if 

available) along with the yellow dot indicating that it must be reviewed first. MyoStrain will not display any strain 

calculations until the mesh has been manually reviewed.  As with any automation tool, the analyst is ultimately 

responsible for the quality of the analysis delivered. 

 

Figure 9-4: Newly imported dataset using Semi Auto Contouring feature 
 

In Figure 9-4, an imported dataset has been contoured using the Semi Auto Contouring feature.  The Display 
Header at the top of the Analysis Window describes the steps necessary to complete the analysis.  By clicking on 
the Accept Mesh button found at the bottom of the Analysis Menu, no changes to the mesh will be made and its 
strain measurements will be displayed in the report (Figure 9-5). 
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Figure 9-5: Accepted mesh with measurements displayed in report 

 
Additionally, any adjustments or modifications to the Semi-Auto Contour will result in the mesh being accepted; 

this also includes applying an RV contour. Once accepted, the mesh will change to the default color schema and its 

measurements will be displayed in the report.  Repeat this process until each of the 6 views have an accepted 

mesh indicated by a green dot in its thumbnail in the Image List. 

 

Figure 9-6: Corrections to an Auto Contour cause the mesh to become accepted and reported on 

   TRADITIONAL MEASUREMENTS WITH SEMI AUTO CONTOURING 
In addition to identifying and contouring End-Systole, the Seni Auto Contour feature will also try to identify and 
contour the End-Diastolic timeframe as well.  Like the End-Systolic mesh, the End-Diastolic timeframe must also be 
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manually reviewed before its calculations will be included in the report.  After accepting or adjusting the End-
Systolic mesh, right-clicking in the Analysis Window and selecting Move to ED or clicking the ED label in the Slice 
Navigator will display MyoStrain’s suggested End-Diastolic mesh. 
 

 
Figure 9-7: Navigating to the suggested End-Diastolic timeframe 

 
 

NOTE: Semi-Auto Contouring workflow will be reversed if the “Use ED First” option is enabled in the Settings 
menu.  ED will be the first timeframe displayed and will transition to the ES timeframe after acceptance. 
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Figure 9-8: Semi-Auto Contouring workflow when ED First is enabled 
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10. MYOWORKLIST 
This chapter provides a detailed writeup of the MyoWorklist, a separate service installed alongside MyoStrain.  This 
MyoWorklist is responsible for managing images being sent to the MyoStrain application, hosting .Myo exam files 
stored in PACS, and how they are presented in the software for analysis.  The MyoWorklist can be accessed from 
MyoStrain to receive new images, preview new images without using an exam credit, revisit previous exams, or can 
run in the background and launch MyoStrain to analyze any dataset received on command. 
  

 MYOWORKLIST LAUNCH AND SETUP 
 

 
Figure 10-1: MyoWorklist running with multiple datasets available 

 

By default, the MyoWorklist service will automatically launch on Startup and will appear shortly after a user logs 
into the workstation.  Additionally, it can be opened from the Desktop shortcut or directly through MyoStrain. 
 

To configure MyoStrain to be able to receive images and exams from a remote modality (PACS server or MRI 
scanner): 
 

Navigate to the directory where MyoStrain was installed, then run the “MyoConfigurator.exe” 
application.  The default installation directory is: “C:\Program Files (x86)\Myocardial 
Solutions\MyoStrain Test\######\Release”, where ###### is the version of MyoStrain installed. 

 

 
Figure 10-2: MyoConfigurator requires Administrative privileges to run 

 
1. Click on the Configure PACS tab of the MyoConfigurator program. 
2. Fill out the 2 available fields in the Client section which identify this workstation to your PACS Server. 

a. Client AE Title – The name which the PACS or scanner identifies as a MyoStrain workstation.   
b. Client Port Number – Port which MyoStrain will listen on to receive images. 
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_________________________________________________________________________________ 

User’s Manual LBL-1015 Rev G Confidential Page 93 

 

c. Directory to Receive Images (uneditable) – Path on the computer where any images 
received through the network are saved.  Exam data will also be saved in this location as 
well. 

d. Save – Press this button to save the information added to this section.  Green confirmation 
text will appear upon a successful save. 

3. Fill out the 3 available fields in the Server section which match a scanner or PACS pushing images to 
the analysis software. 

a. Server AE Title – Application Entity title of the PACS or scanner pushing images to 
MyoStrain. 

b. Server Port Number – Port which MyoStrain will transmit information back to the server. 
c. Server IP – IP address of the PACS server or scanner sending images. 
d. Receive Only – This option sets MyoStrain to ONLY receive images from a server entity 

without sending information back.  Selecting this option will only require the server’s AE Title 
to be entered to receive images.   

 

 
Figure 10-3: Sample Configure PACS setup 

 

NOTE: Images received through DICOM Connectivity will be handled the same as images added directly to the 
default receiving directory. 

 
4. Pressing the Add button will save the current server’s configuration.  The server information will 

appear in a list at the bottom.  Pressing the red minus button next to a server will delete that 
connection. 

 

 WORKLIST AND LANGUAGE SETTINGS 
Worklist and language settings can also be changed in the MyoConfigurator tool.  The Worklist settings are found 
in the Settings tab of the MyoConfigurator tool. 
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Figure 10-4: Worklist Settings window 

 

• Choose Images Path – Clicking the ellipsis button will bring up a Browse for Folder dialog box.  Selecting a 
folder from this location will cause MyoStrain to store all images received through the network in this 
folder. 

• Select Language – Selecting a language from this dropdown menu will restart the application and change 
the default language to the selected one. 

• Study Time Interval – Amount of time MyoStrain will wait when receiving images before timing out. 

• Study Folder Name – Folders created by MyoStrain to store images received through the Worklist will be 
created using the criteria listed in the dropdown menu. 

o Patient Name – (0010,0010) 
o Patient ID - (0010,0020) 
o Accession Number – (0008,0050) 

• Application Mode – Determines whether the Worklist will queue exams for analysis (Multi Mode, 10.2.1) 
or display the images immediately when they are received and create a new exam (Single Mode, 10.2.2). 

 

10.2.1 MULTI MODE (WORKLIST ENABLED) 
Multi-Mode is the default state of the MyoWorklist.  When active, regardless of whether MyoStrain is open or 
closed, the MyoWorklist will run in the background and receive any datasets pushed to it for analysis.  If the 
MyoStrain application is closed, the worklist will automatically launch the program and load the appropriate 
dataset. 
 

NOTE: Check the Import Status is set to Ready or Sent before sending data to MyoStrain before processing. 
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Figure 10-5: MyoWorklist actively downloading datasets 

 

Once a dataset is received by the program, it is added to the active list.  The images are organized based on their 

DICOM information and is displayed for easy access. Clicking on the title of any column in the MyoWorklist will sort 

the available datasets by that criteria.  Default DICOM tags (####,####) are provided for each entry if applicable. 

• Patient Name – (0010,0010) - Name of the patient as listed in the DICOM header 

• Patient ID – (0010,0020) - The ID of the patient 

• Accession Number – (0008,0050) - A unique ID that is generated for a patient record 

• Scan Date – (0008,0020) - YYYY/MM/DD of acquisition of listed dataset 

• Received – YYYY/MM/DD of when this dataset was pushed to the workstation for analysis. 

• Import Status – Details what state the images are currently: 

o Ready – All images in the dataset have been received and is ready for analysis. 

o Sent – This dataset has been sent to MyoStrain for analysis. 

o Downloading – This dataset is still being downloaded.  Analysis cannot begin until all images 

have been received. 

• Preview – This launches the Preview window.  More information about the Preview window can be found 

in chapter 8. 

• New Exam - This field holds the Start button, which will launch these images in a new MyoStrain exam. 

MyoStrain will launch if it is not open already 

• Open Exam – If a patient has already been analyzed and the exam file was exported to PACS,  MyoStrain 

will convert the DICOM exam file into a MyoStrain exam file which can be accessed by clicking the Open 

button (see Figure 10-6). 

• Clear – This button will remove the dataset assigned to it.  The images will not be deleted from the hard 

drive, but the ability to launch them from the worklist will be. 

After launching the MyoStrain program using the MyoWorklist, additional exams can be launched from here, or 

from the worklist found within MyoStrain itself. 

 

NOTE: MyoStrain will automatically determine if a Strain or Stress exam will be launched based on the images 
received.  If Stress images are included with the patient scan, a Stress exam credit will be consumed. Opening an 
existing exam will not consume an exam credit. 
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Figure 10-6: Opening a previously analyzed exam stored on PACS and sent to MyoStrain 
 

 

10.2.2 SINGLE MODE (WORKLIST DISABLED) 
The worklist is designed to manage workstations which are responsible for analyzing multiple analyses coming 
from different systems, or for queueing exams for later analysis if they cannot be analyzed concurrently with the 
patient scan.  Clicking on the Single Mode button found at the bottom of the MyoConfigurator will cause the 
worklist to no longer queue datasets and will instead push the images directly to MyoStrain for analysis.  Switching 
the MyoWorklist into Single Mode will also require a workstation restart. 
 

 

Images sent to the workstation when running in Single Mode will only be stored and read if 
MyoStrain is open and running. Otherwise, they will not be stored, and an error will be shown from 
PACS.   

 

 

  IN-PROGRAM MYOWORKLIST 
When working within MyoStrain, the MyoWorklist can be accessed by clicking the New Exam from Worklist option 
from the File menu (Figure 10-8). 
 

  
Figure 10-7: Open from Worklist option in the MyoStrain File menu 
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The New Exam from Worklist option will launch an in-application version of the MyoWorklist.  From here, pressing 

the Start button will close the currently open exam (if available) and launch the selected one. 

 

Figure 10-8: New Exam from Worklist dialog box as seen from MyoStrain 

 

NOTE: MyoStrain will automatically determine if a Strain or Stress exam will be launched based on the images 
received.  If Stress images are included with the patient scan, a Stress exam credit will be consumed.  Opening an 
old exam will not consume an exam credit. 
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11. EXTERNAL REFERENCES 
This section outlines any references to outside materials not produced by Myocardial Solutions.  These include 
third-party software libraries and research references. 
 

 THIRD PARTY APPLICATIONS 
MyoStrain makes use of multiple third-party libraries which assist with processing and displaying information. 

 

• DICOM# - Library for processing DICOM formatted data 

• SharpZipLib – Library for archive processing 

• IJG Library – Library for processing JPEG compressed DICOM data 

• LibJpeg.Net – Library for compressing JPEG data 

• EO.PDF – Used for processing and formatting PDF documents 

• Log4Net – Used for generating log files 

• OpenCV – Image and video processing library 

• SharpAVI – Library used to export videos from MyoStrain. 

• NumPY – Function library for scientific computation 

• ProtoBuf – Saves and restores predictive models 

• TensorFlow – Machine learning for semi-automated contouring 

• Python 3 Interpreter – Processes scripts for semi-automated contouring 

• Python Image Library – Image processing library 

• GMA.QRCodeNet – Library which creates QR Codes available on MyoStrain reports. 

• SKLearn – Library for data clustering used in image processing 

• Ghostscript – Used for wrapping PDF/JPEG images for DICOM usage 

• MediaToolKit – Library for video processing and export 

• Newtonsoft.Json – Library used for generating QR codes 

• TopShelf – Service implementation in MyoStrain 
 
Additionally, MyoStrain includes the following applications as part of its installation: 
 

• .NET Framework 4.8 (if not already available) 

• Visual C++ Redistributable Package 2019 
 
Detailed information related to these libraries including version numbers are available upon request through 
support@myocardialsolutions.com. 

 MYOSTRAIN STRAIN SCALE 
More information regarding the strain legend used in the MyoStrain program can be found from the following 
papers:   

• Neizel M, et al. “Strain-encoded MRI for evaluation of left ventricular function and transmurality in acute 
myocardial infarction.” Circ Cardiovasc Imaging. 2009;2(2):116-122 

11 

mailto:support@myocardialsolutions.com


 

 
_________________________________________________________________________________ 

User’s Manual LBL-1015 Rev G Confidential Page 99 

 

• Wong DT, et al. “Magnetic resonance-derived circumferential strain provides a superior and incremental 
assessment of improvement in contractile function in patients early after ST-segment elevation 
myocardial infarction.” European Radiology. 2014;24:1219-1228. 

• Oyama-Manabe N, et al. “Identification and further differentiation of subendocardial and transmural 
myocardial infarction by fast strain-encoded (SENC) magnetic resonance imaging at 3.0 Tesla” European 
Radiology. 2011;21(11):2362-2368. 

• Neizel M, et al. “Impact of Systolic and Diastolic Deformation Indexes Assessed by Strain-Encoded Imaging 
to Predict Persistent Severe Myocardial Dysfunction in Patients After Acute Myocardial Infarction at 
Follow-Up.” Journal of the American College of Cardiology. 2010;56:1056-1062. 

• Choi E-Y, et al. “Prognostic value of myocardial circumferential strain for incident heart failure and 
cardiovascular events in asymptomatic individuals: the Multi-Ethnic Study of Atherosclerosis.” European 
Heart Journal. 2013;34:2354-2361. 

• Koos R, et al. “Layer-specific strain-encoded MRI for the evaluation of left ventricular function and infarct 
transmurality in patients with chronic coronary artery disease.” Int J Cardiol. 2013;166:85-89.Korosoglou, 
G et al. “Fast Strain-Encoded Cardiac Magnetic Resonance for Diagnostic Classification and Risk 
Stratification of Heart Failure Patients” JACC Cardiovasc Imaging 2021 Jun;14(6):1177-1188. doi: 
10.1016/j.jcmg.2020.10.024. 

 AHA MODEL 
The AHA Models used in MyoStrain are derived from the following publication: 
 
M. Cerqueira et al., “Standardize Myocardial Segmentation and Nomenclature for Tomographic Imaging of the 
Heart,” Circulation, 2002;105:539-542 
 

 NORMAL RANGES OF MYOSTRAIN MEASUREMENTS 
The output of the SENC images post-processing is a report that shows various measurements. One set of 
measurements is the traditional global measurements (ejection fraction, chamber volumes and masses). These 
measurements are presented with the normal ranges published by Zhan et al [1]. The other set is the strain 
measurements (circumferential and longitudinal) presented with the normal ranges of strains as published by 
Neizel et al [2]. 
 
Traditional Global measurements (LVEF and indexed LVEDV, LVESV, LVSV and LVMass):  
[1] Y. Zhan et al., "Derivation of consolidated normal reference values for right and left ventricular quantification 

by cardiac magnetic resonance using a novel meta-analytic approach," Journal of Cardiovascular Magnetic 
Resonance, vol. 18, no. 1, p. O75, 2016/01/27 2016. 

 
Strain (circumferential and longitudinal): 
[2] M Neizel  et al. “Strain-encoded MRI for evaluation of left ventricular function and transmurality in acute 

myocardial infarction.” Circ Cardiovasc Imaging. 2009;2(2):116-122. 
 

 ACCURACY OF MYOSTRAIN MEASUREMENTS 
The accuracy of MyoStrain measurements are determined by the Limit of Agreement (LOA). The LOA is the range 
that covers the 95% of differences between the measurement of the two devices. For example, if MyoStrain 
measures LVEF of 67%, the LOA of (-13,+10) means that 95% for a large number LVEF values of the same subject 
measured using the gold standard Cine MRI will lie between 54% and 77%. The LOA depends on many factors, 
including images quality and inter-operator and inter-observer variabilities. This LOA was originally based on two 

https://www.jacc.org/doi/full/10.1016/j.jcmg.2020.10.024
https://www.jacc.org/doi/full/10.1016/j.jcmg.2020.10.024
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predicate devices (Diagnosoft HARP for Strain, Diagnosoft VIRTUE for traditional measurements), however these 
ranges have been reduced to reflect measured accuracy in MyoStrain.  
 
To demonstrate the accuracy of MyoStrain measurements, we calculated the correlation coefficients using 
Diagnosoft VIRTUE 5.51 measurements of the LV EF, End-Diastolic Volume (EDV), End-Systolic Volume (ESV), Mass, 
and Stroke Volume (SV).  We considered the measurements accurate by requiring that the variations in global 
measurements due to workstation and user variability to be within the accepted cutoffs of published guidelines 
and clinical results.  We specified that targeted correlation coefficients of the global measures generated by 
MyoStrain, in comparison to the gold standard cardiac MRI, must be equal or better than the following:  EF:  
R=0.79, p<0.001, EDV:  R=0.84, p<0.001, ESV:  R=0.94, p<0.001, SV:  R=0.31, p=0.05.   
Since the LV Mass is similar to LV volumes, we decided that the R and p values follow the same criteria for EDV.  
Our acceptance criteria required the following bounds for the 95% range of measurements differences between 
MyoStrain and Diagnosoft VIRTUE: 
 

• LVEF: (-20,+20) 

• LVEDV: (-45,+45) 

• LVESV: (-25,+25) 

• LVSV: (-40, +40) 

• LVMass: (-35, +35) 
 
 Based on a sample size N=23 of healthy subjects and patients, MyoStrain demonstrated the following acceptable 
LOA: 
 

• LVEF: (-13,+10)  

• LVEDV: (-40,+35)  

• LVESV: (-19,+21)  

• LVSV: (-36,+29)   

• LVMass: (-19,+30) 
 
The Bland-Altman Graphs of these calculations can be seen below: 
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The LOA and accuracy of Strain calculations were based on tests using a mechanical phantom with known actual 
strain values. Phantom analysis demonstrated that MyoStrain has the acceptable LOA of (-5,+5).  Note that LOA of 
MyoStrain of Strain measured in vivo in humans is unknown, could be different. 
 
The aforementioned accuracies of measurements are associated with images that were correctly acquired and 
analyzed by trained operators. It is the responsibility of the trained MRI operator and MyoStrain users to check the 
quality of the acquired images before post-processing them using MyoStrain.  
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12. GLOSSARY 
 
This chapter lists the various terms used in this User Manual along with their meaning. 
 
AHA Model 
The standardized 17 segment heart representation set by the American Heart Association 
 
Anonymous 
Without identification. Without any additional external information. The identity of the person cannot be 
established. 
 
CINE 
Movie-like MR imaging.  In CINE, MR imaging data is acquired using cardiac gating to form a "movie" sequence of a 
structure moving in synchrony with the heart. 
 
EF 
Ejection Fraction 
 
Endocardium 
The innermost layer of tissue that lines the chambers of the heart. 
 
Epicardium 
The outer layer of heart tissue. 
 
Exam 
A specific type of imaging for specific information.  For example, MR tagged images acquired under stress. 
 
GUI 
Graphical User Interface 
 
LV 
Left Ventricle 
 
LVEDV 
Left Ventricular End Diastolic Volume 
 
LVESV 
Left Ventricular End Systolic Volume 
 
LVSV 
Left Ventricular Stroke Volume 
 
 
 

12 
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MR 
Magnetic Resonance - is primarily a medical imaging technique most commonly used in radiology to visualize the 
internal structure and function of the body.  
 
Myocardium 
The muscular tissue of the heart. This is typically referring to the middle layer of the heart wall. 
 
RV  
Right Ventricle 
 
Series 
Collection of MR images acquired in a single MR scan. 
 
SENC 
Strain Encoding 
 
Strain 
Geometrical measure of deformation representing the relative displacement between particles in a material body. 
 
Stress 
Measure of how the myocardium responds to exertion.  
 
Study 
A collection of series scanned in the same session for a subject. 
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Stress 2.6, 6, 7.3.1 
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